
 

Universitäts-Rechenzentrum Trier 
  
AWS.RG.3   
 
 
 
 

 Trier, den 11.11.2009 
 
 
 
 

Bernhard Baltes-Götz 
 
 
 

 

Thematische Kartographie 
mit RegioGraph 10 

 
 
 

 



1 EINLEITUNG 5 

2 ÜBERBLICK 7 

2.1 Geographische Objekte, Schichten und Karten 7 

2.2 Tabellen mit Daten zu den Objekten einer Kartenschicht 7 

2.3 Projekte und Arbeitsblätter 8 

3 EINSTIEG IN DAS ARBEITEN MIT REGIOGRAPH 9 

3.1 RegioGraph starten 9 

3.2 Neues Projekt erstellen 9 

3.3 Schichtvorlagen in ein Projekt übernehmen 10 

3.4 Arbeitsblatt erstellen 12 

3.5 Landkarte erstellen 12 

3.6 Projekt speichern, reorganisieren 13 

3.7 Weitere Optionen der Projektverwaltung 14 

3.8 Landkarten- und Layout-Modus 14 

3.9 Arbeitsplatz umgestalten 14 

4 GESTALTUNGSMÖGLICHKEITEN IM LAYOUT-MODUS 17 

4.1 Seitenformat ändern 17 

4.2 Bearbeitungen zurücknehmen bzw. wiederherstellen 17 

4.3 Neue Grafikobjekte einfügen 17 

4.4 Grafikobjekte markieren 20 

4.5 Grafikobjekte bearbeiten 20 
4.5.1 Größe und Position 20 
4.5.2 Attribute 20 
4.5.3 Eigenschaftsdialog 24 
4.5.4 Linien und Polygone editieren 24 
4.5.5 Übertragung von Formaten 24 
4.5.6 Objektstapelung verändern 24 

4.6 Anpassungsmaßnahmen 25 
4.6.1 Grafikobjekte an einem Referenzobjekt ausrichten 25 
4.6.2 Zentrieren in Bezug auf das Arbeitsblatt 25 
4.6.3 Grafikobjekte verteilen 25 
4.6.4 Größe anpassen 26 

4.7 Grafikobjekte gruppieren 26 



 

AWS.RG.3: 11. November 2009 3 

Thematische Kartographie mit RegioGraph 10 
 

5 LANDKARTENBEARBEITUNG 27 

5.1 Tipps zur Vermeidung von Ärger 27 

5.2 Karteninhaltsfenster und Arbeitslayer 27 

5.3 Ausschnitt definieren 29 

5.4 Geographische Objekte auswählen 30 

5.5 Landkarte einpassen 32 

5.6 Aus- und Einblenden von geographischen Objekten 33 

5.7 Beschriftungen anpassen 33 

5.8 Informationen zu geographischen Objekten abrufen 35 

5.9 Entfernungen messen 37 

5.10 Geographische Orientierungshilfen für Landkarten 38 
5.10.1 Maßstab eintragen 38 
5.10.2 Nordpfeil eintragen 39 
5.10.3 Gitternetz anzeigen 39 

5.11 Perspektive wählen 40 

5.12 Projektion einstellen 41 

5.13 Neue Layer anlegen und bearbeiten 42 
5.13.1 Punktelayer 42 
5.13.2 Linienlayer 44 
5.13.3 Flächenlayer 46 
5.13.4 Objektelayer 46 

6 INDIVIDUELLE GESTALTUNG UND STANDARDEINSTELLUNGEN 48 

6.1 Individuelle Gestaltung von Landkartenschichten 48 

6.2 Transparente Gebiets- oder Flächenschichten 48 

6.3 Standardeinstellungen für Layer 49 

7 MIT TABELLEN ARBEITEN 51 

7.1 Daten in eine Layertabelle importieren 51 

7.2 Manuelle Tabellenbearbeitung 57 
7.2.1 Spalten erstellen und modifizieren 57 

7.2.1.1 Neue Spalte erstellen 57 
7.2.1.2 Dialogfeld Spalteneigenschaften 57 
7.2.1.3 Weitere Modifikationen einer Tabelle 60 

7.2.2 Tabellenzeilen bzw. geographische Objekte markieren 61 



 

AWS.RG.3: 11. November 2009 4 

Thematische Kartographie mit RegioGraph 10 
 

8 KARTOGRAPHISCHE VISUALISIERUNG VON DATEN 63 

8.1 Ausprägungen eines Merkmals mit beliebigem Messniveau 63 

8.2 Piktogrammdarstellung 66 

8.3 Klassen einer numerischen Variablen durch Füllstile oder Linientypen darstellen 69 

8.4 Klassen einer numerischen Variablen durch Symbole darstellen 72 

8.5 Punktdichtedarstellung 74 

8.6 Portfolio-Darstellung 77 

8.7 Symbol-Portfolio 80 

8.8 Dreidimensionale Darstellungen 81 
8.8.1 3D-Gitter (Gebirgs-Darstellung) 81 
8.8.2 3D-Prismen - Darstellung 83 

8.9 Darstellung durch Diagramme 84 

8.10 Entfernung zum nächsten oder zum zugeordneten Standort 88 

8.11 ABC-Analyse 90 

8.12 Radialanalyse 91 

9 GRAFIK-EXPORT 94 

9.1 Export via Zwischenablage 94 

9.2 Export in eine Datei 94 

9.3 HTML-Export 95 

10 WEITERE MÖGLICHKEITEN IN REGIOGRAPH 98 

11 STICHWORTREGISTER 99 
 
 
 
 
 
 
 
Herausgeber:  Universitäts-Rechenzentrum Trier 

Universitätsring 15 
D-54286 Trier 
Tel.: (0651) 201-3417, Fax.: (0651) 3921 

Leiter: Dr. Peter Leinen 
Autor: Bernhard Baltes-Götz 
 E-Mail: baltes@uni-trier.de 
Copyright  2009; URT 



 

AWS.RG.3: 11. November 2009 5 

Thematische Kartographie mit RegioGraph 10 
 

1 Einleitung 
RegioGraph unterstützt als geographisches Informationssystem (GIS) die Darstellung und Analyse von 
raumbezogenen Daten. Das von der GfK GeoMarketing GmbH entwickelte Programm kümmert sich als 
Business-GIS speziell um Kunden-, Markt- und Unternehmensdaten, eignet sich aber auch für nichtkom-
merzielle Anwendungen. Ein einfaches Anwendungsbeispiel ist die folgende Deutschlandkarte mit farb-
lich sowie numerisch dargestellten Daten über die Verkehrssicherheit in den Bundesländern: 

 
Beim Einsatz von RegioGraph verwendet man in der Regel eine der zahlreichen mitgelieferten Karten 
zur Visualisierung von Daten, die meist aus anderen Quellen (z.B. aus eigener Forschungsarbeit) stam-
men. Über das Basispaket mit Karten zu Deutschland, Österreich und Schweiz hinaus bietet der Herstel-
ler Karten zu allen Regionen der Erde und zu vielen thematischen Schwerpunkten an. An der Universität 
Trier sind detaillierte Karten zu den meisten Ländern Europas verfügbar. 
 
Außerdem kann RegioGraph Karten in den Fremdformaten ESRI Shape und MapInfo Interchange For-
mat) importieren. 
 

In der folgenden Tabelle sind exemplarisch die zu Deutschland verfügbaren Karten aufgelistet, wobei 
nach Gebiets-, Punkte-, Linien- und Flächenschichten (siehe unten) unterschieden wird:  

http://www.gfk-geomarketing.de/�
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Gebietsschichten 

Administrative Gebiete 
Bundesländer 2008 
Gemeinden 2008 
Regierungsbezirke 2008 
Stadt- und Landkreise 2008 

Postleitzahlgebiete 
Postleitbereiche 2008 
Postleitregionen 2-stellig 2008 
Postleitzahlen 3-stellig 2008 
Postleitzahlen 4-stellig 2008 
Postleitzahlen 5-stellig 2008 
Postleitzonen 1-stellig 2008 

Sonderkarten 
Arbeitsamtsbezirke 2008 
Arbeitsamtsdienststellen 2008 
IHK-Bezirke 2008 
Kassenärztliche Vereinigungsgebiete 2008 
Landesarbeitsamtsbezirke 2008 
Nielsen-Gebiete 2008 
Nielsen Standard-Regionen 2008 
Raumordnungsregionen 2008 

Linienschichten 

Autobahnen 2008 
Hauptstraßen 2008 
Nebenstraßen 2008 
Ortsverbindungsstraßen 2008 

Fähren 
Flüsse 
Nebenflüsse 
Eisenbahnnetz 2008 

Punktschichten 

Städte < 10.000 Einwohner 
Städte 10.000 – 20.000 Einwohner 
Städte 20.000 – 50.000 Einwohner 

Städte 50.000 – 100.000 Einwohner 
Städte >100.000 Einwohner 
Flughäfen 

Flächenschichten 

Seen groß 
Seen klein 
Siedlungsflächen 
Waldflächen 
Industrieflächen 

Höhenschichten 
Sand/Watt 
Flughafengelände 
Flughafen-Rollbahnen 

 
Eine RegioGraph-Karte lässt sich z.B. durch Ausblenden irrelevanter Gebiete oder durch Zusammenfas-
sen von Gebieten an spezielle Aufgabenstellungen anpassen. 
 
Zu jeder RegioGraph-Kartenschicht gehört eine Tabelle, deren Zeilen mit den geographischen Objekten 
der Kartenschicht verknüpft sind. Die in den Spalten der Tabelle enthaltenen Merkmale der geographi-
schen Objekte können auf vielfältige Weise in der Karte visualisiert werden, z.B. die relative Häufigkeit 
der Unfallopfer in den Bundesländern durch verschiedene Farben in der zugehörigen Gebietsschicht. In 
diesem Manuskript werden zahlreiche weitere Darstellungsoptionen beschrieben. Die zu visualisierenden 
Daten können aus zahlreichen Quellen in die Tabellen zu den mit RegioGraph erworbenen oder impor-
tierten Kartenschichten übernommen werden. 
 
Die RegioGraph-Version 10 enthält erstmals neben den Karten auch umfangreiche Kaufkraftdaten der 
GfK (Gesellschaft für Konsumforschung) zu Deutschland, Österreich und der Schweiz. 
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2 Überblick 

2.1 Geographische Objekte, Schichten und Karten 

Beim Arbeiten mit RegioGraph sind folgende Kategorien geographischer Objekte zu unterscheiden: 

 Gebiete  
Eine Gesamtfläche wird durch Grenzlinien in benachbarte Gebiete zerlegt (siehe Einleitungsbeispiel 
mit den deutschen Bundesländern als Gebieten). 

 Flächen  
Im Unterschied zu Gebieten verfügen Flächen im Allgemeinen nicht über gemeinsame Grenzen (z.B. 
Seen, Waldgebiete etc.). 

 Punkte  
Mit Punkten werden auf einer Karte z.B. Orte markiert. 

 Linien  
Mit Linien werden z.B. Flüsse, Straßen und Eisenbahnstrecken dargestellt. 

 
In RegioGraph kann jede Karte aus mehreren Schichten bestehen, die jeweils geographische Objekte aus 
einer Kategorie enthalten. 
 
Sie können .... 

 die von RegioGraph mitgelieferten Schichten unverändert verwenden 
 mitgelieferte Schichten modifizieren (z.B. Punkte ergänzen) 
 Schichten importieren 
 eigene Punkte-, Linien oder Flächenschichten herstellen. 
 
Neben den geographischen Schichten kann man auch noch Schichten mit beliebigen Objekten  (z.B. 
Pfeilen, Beschriftungen) anlegen, die einen Bezug zu den geographischen Objekten haben und daher z.B. 
bei einer Maßstabsveränderung analog transformiert werden sollen. 
 

2.2 Tabellen mit Daten zu den Objekten einer Kartenschicht 

Eine wesentliche Leistung von RegioGraph besteht in der Möglichkeit, die geographischen Objekte einer 
Kartenschicht mit Daten zu verknüpfen, wobei die Daten in der Karte auf unterschiedliche Weise ange-
zeigt werden können (z.B. durch Farben oder Kreisdiagramme). Dazu besitzt jedes geographische Objekt 
einer Kartenschicht eine eindeutige Kennung. Zu jeder Kartenschicht gehört eine Tabelle, die für jedes 
geographische Objekt eine Zeile enthält. In der ersten Tabellenspalte stehen die Objektkennungen, weite-
re Spalten können beliebig viele Merkmale zur Beschreibung der Objekte enthalten. In der Terminologie 
der angewandten Statistik entspricht also jedes geographische Objekt einem Fall und jede Tabellenspalte 
einer Variablen. 
 
In der Tabelle zur Gebietsschicht der deutschen Bundesländer sind im Auslieferungszustand bereits etli-
che Merkmale enthalten (z.B. Zahl der Einwohner, Kaufkraftindex): 
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Wir werden diese Tabelle später per Datenimport noch erheblich erweitern und dabei öffentlich zugängli-
che Informationen des statistischen Bundesamts verwenden. 
 

2.3 Projekte und Arbeitsblätter 

Ein RegioGraph-Projekt kann ein oder mehrere Arbeitsblätter enthalten, auf denen jeweils eine präsen-
tier- bzw. exportierbare Seite aufgebaut wird. 
 
Auf einem Arbeitsblatt wird man in der Regel eine Landkarte unterbringen, aber es dürfen auch mehrere 
sein (bei entsprechend großem Seitenformat). Wie eben berichtet, darf jede Landkarte aus mehreren 
Schichten bestehen, die jeweils geographische Objekte eines bestimmten Typs enthalten (z.B. Gebiete, 
Linien oder Punkte). Zu jeder Schicht gehört eine Tabelle mit Informationen über ihre geographischen 
Objekte. 
 
Neben den Landkarten können auf einem Arbeitsblatt auch Texte, Zeichnungselemente (z.B. Linien, 
Rechtecke, Ellipsen etc.), Multimedia-Objekte (z.B. Videos, Tonsequenzen) und Symbole (Abbildungen) 
untergebracht werden. 
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3 Einstieg in das Arbeiten mit RegioGraph 

3.1 RegioGraph starten 

Auf den vom Rechenzentrum betreuten Pool-PCs wird RegioGraph 10 über folgenden Menübefehl ge-
startet: 

Start > Programme > Wissenschaftliche Programme > RegioGraph > RegioGraph 10 

3.2 Neues Projekt erstellen 

Wählen Sie im Startassistenten 

 
die Option Ein neues, leeres Projekt erstellen, oder verwenden Sie den analogen Menübefehl 

Datei > Neues Projekt 

Legen Sie anschließend das Verzeichnis und den Namen für die neue Projektdatei fest, z.B.: 

 
Beim RegioGraph-Einsatz im Campusnetz der Universität Trier wird das folgende Projektbasisverzeich-
nis empfohlen und beim ersten RegioGraph-Start automatisch angelegt: 

U:\Eigene Dateien\Regio\Projekte 
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Bei den meisten RegioGraph-Projekten finden alle Bestandteile (Schichten, Tabellen etc.) in einer Datei 
Platz, und diese Projektdatei ist im angegebenen Projektbasisverzeichnis gut aufgehoben. Geben Sie den 
Namen der Projektdatei am besten ohne Namenserweiterung an, womit die Voreinstellung .gfk über-
nommen wird. Bei einem umfangreichen Projekt mit vielen Kartenschichten und Arbeitsblättern kann die 
Projektdatei einen erheblichen Umfang erreichen (z.B. 1 GB und mehr), so dass entsprechend viel freier 
Speicherplatz benötigt wird. Gehören zu einem Projekt auch Hilfsdateien (z.B. mit zu importierenden 
Kartenschichten oder Daten), dann sollte man dem Projekt der Übersichtlichkeit halber einen Unterordner 
spendieren (siehe Beispiel). 
 
Nach dem Quittieren der Dialogbox Neues Projekt finden Sie in der Projektverwaltung (hier der 
Übersichtlichkeit halber von der Standardposition am linken Rand des RegioGraph-Fensters „losgeris-
sen“) zwei Ordner zur Aufnahme von Arbeitsblättern und Layern (Schichten), wobei RegioGraph spontan 
ein erstes Arbeitsblatt angelegt hat: 

 
Ein Projekt kann beliebig viele Arbeitsblätter enthalten. Im Ordner Layer werden die (eventuell in meh-
reren Karten) verwendeten Schichten abgelegt (Gebietslayer, Punktelayer, Linienlayer, Flächenlayer, 
Objektelayer). 
 

3.3 Schichtvorlagen in ein Projekt übernehmen 

In der Kartenbibliothek werden die aktuell verfügbaren Kartenvorlagen angezeigt. Beim RegioGraph-
Einsatz im Campusnetz der Universität Trier finden Sie hier per Voreinstellung Kartenvorlagen zu 
Deutschland, Österreich und der Schweiz: 

 
Um eine Schichtvorlage in das aktuelle Projekt zu übernehmen, wird sie per Maus von der Kartenbiblio-
thek auf die Projektverwaltung gezogen, woraufhin sie im Layer-Ordner landet, z.B.: 

 
Wählen Sie bitte für die anschließenden Übungen aus dem Kartenbibliotheksordner 

Deutschland 2008 > Administrative Gebiete 

die Gebietsschicht 

Deutschland Bundesländer 2008 

 



 

AWS.RG.3: 11. November 2009 11 

Thematische Kartographie mit RegioGraph 10 
 
Ist im Projekt bereits ein Arbeitsblatt vorhanden und geöffnet (siehe unten), kann man eine Schicht aus 
der Kartenbibliothek per Maus direkt auf das Arbeitsblatt befördern, wobei automatisch 

 auf dem Arbeitsplatt eine Karte angelegt, 
 und die Schicht in die Projektverwaltung aufgenommen wird. 
 
Um an Karten zu anderen Ländern und Kontinenten heranzukommen, müssen Sie über den Menübefehl 

Extras > Optionen > Verzeichnisse 

 das Kartenbibliotheks-Verzeichnis ändern: 

 

Nach einem Mausklick auf den zugehörigen Erweiterungsschalter  können Sie dies in folgender Dia-
logbox mit einigen weiteren Mausklicks erledigen, z.B.: 

 
Wenn Sie z.B. den Pfad 

W:\Vorlagen\Edition 2008\Europa 2007\Europäische Länder 2007\Luxemburg 2007 

wählen, stehen anschließend in der Kartenbibliothek aktuelle Karten aus unserem Nachbarland bereit: 
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Im Ordner W:\Vorlagen\Edition 2001 finden Sie (weniger detaillierte und eventuell veraltete) Karten 
zu Ländern außerhalb Europas: 

 
 

3.4 Arbeitsblatt erstellen 

 Auf einem Arbeitsblatt wird jeweils eine eigenständige Präsentation erstellt, die Landkarten und andere 
Objekte (z.B. Beschriftungen, Grafiken) enthalten darf. Wie Sie bereits wissen, legt RegioGraph zu ei-
nem neuen Projekt spontan ein erstes Arbeitsblatt an: 

 
 
Mit dem Menübefehl 

Datei > Neues Arbeitsblatt 

oder mit dem Symbol  fordert man bei Bedarf ein weiteres Arbeitsblatt an. Es erscheint im Dokumen-
tenbereich von RegioGraph und wird auch in der Projektverwaltung angezeigt. 
 
Via Kontextmenü oder nach einem Mausklick auf seinen bereits markierten Namen lässt sich ein Ar-
beitsblatt individuell benennen. 
 

3.5 Landkarte erstellen 

Ziehen Sie nun die Gebietsschicht Deutschland Bundesländer 2008 aus dem Layer-Ordner der 
Projektverwaltung auf das Arbeitsblatt, wobei eine neue Landkartenbox entsteht: 
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Im Fenster mit dem Karteninhalt (per Voreinstellung oben links auf dem RegioGraph-Arbeitsplatz zu 
finden) werden alle Schichten der aktiven Karte angezeigt und verwaltet. Bei einer frisch erstellten Karte 
ist hier genau eine Schicht zu finden, wobei man in der Regel mit einer Gebietsschicht startet. Weitere 
Layer zieht man bei Bedarf aus der Projektverwaltung oder der Kartenbibliothek auf die Karte, wobei aus 
der Bibliothek direkt in eine Karte übernommene Vorlagen automatisch auch in die Projektverwaltung 
aufgenommen werden. 
 

3.6 Projekt speichern, reorganisieren 

Das Speichern des aktuellen Projekts veranlasst man per Mausklick auf das Symbol  oder mit dem Me-
nübefehl 

Datei > Alles speichern 
 
Alle Arbeitsblätter, Landkarten und Schichten eines Projekts werden in der Projektdatei gespeichert, die 
dementsprechend groß werden kann. Durch das Löschen von Arbeitsblättern oder Schichten kann es zu 
einer Fragmentierung der Projektdatei und zu einer Verschwendung von Speicherplatz kommen. Mit dem 
folgenden Menübefehl kann man die Projektdatei defragmentieren und damit ihren Speicherbedarf mini-
mieren: 

Datei > Reorganisieren 

Vorsichtshalber sollte man vor dem Reorganisieren eine Sicherheitskopie der Projektdatei anlegen. 
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3.7 Weitere Optionen der Projektverwaltung 

Mit der Projektverwaltung kann man über das Kontextmenü des betroffenen Objekts u.a. … 

 ein Arbeitsblatt oder eine Schicht löschen 
 ein Arbeitsblatt duplizieren 
 ein Arbeitsblatt in eine Datei (mit der Namenserweiterung map) exportieren oder von dort importieren 

(via Kontextmenü zum Ordner Arbeitsblätter) 
 eine Arbeitsblattvorlage (siehe unten) erstellen oder öffnen (via Kontextmenü zum Ordner Arbeits-

blätter) 
 eine Schicht in die Windows-Zwischenablage kopieren oder von dort einfügen (via Kontextmenü zum 

Ordner Layer) 
 eine modifizierte Schicht (siehe unten) in eine Datei (mit der Namenserweiterung lay) exportieren 
 zur Förderung der Übersichtlichkeit bei komplexen Projekten Unterordner zum Arbeitsblatt- oder 

Layer-Ordner anlegen 
 
Wird aus einem Arbeitsblatt eine Arbeitsblattvorlage erstellt, landen alle Grafikelemente und -attribute 
(z.B. Beschriftungen, ein flächendeckendes Rechteck zur Hintergrundeinfärbung, eine illustrierende Ab-
bildung) in einer Datei mit der Namenserweiterung fra, wobei von Landkarten nur die leeren Boxen ein-
bezogen werden. Beim Öffnen einer Arbeitsblattvorlage entsteht ein neues Arbeitsblatt, dessen Landkar-
tenboxen ggf. leer sind. Auf der Webseite 

http://www.gfk-geomarketing.de/software/downloads/arbeitsblattvorlagen.html 

bietet der RegioGraph-Hersteller einige Arbeitsblattvorlagen an. 
 

3.8 Landkarten- und Layout-Modus 

RegioGraph kennt zwei Bearbeitungsmodi: 

 Landkarten-Modus 
Er ist für die Landkarten- bzw. Schichtbearbeitung gedacht und bietet entsprechende Werkzeuge (z.B. 
zur Wahl eines Maßstabs oder zum Einfärben von Gebieten aufgrund eines Merkmals). 

 Layout-Modus 
Im Layout-Modus werden die Karten auf dem aktuellen Arbeitsblatt wie Grafiken behandelt. Sie kön-
nen z.B. vergrößert, verkleinert oder verschoben werden. Außerdem können sonstige Objekte auf dem 
Arbeitsblatt erstellt und bearbeitet werden (z.B. Beschriftungen). Nach einer Größenänderung bei einer 
Landkartenbox ist meist im Landkarten-Modus der Maßstab anzupassen (siehe unten). 

Um für eine Karte den Landkarten-Modus zu aktivieren, setzt man einen Doppelklick darauf. Anschlie-
ßend erhält die Karte einen schraffierten Markierungsrahmen in einer vom Windows-Farbschema abhän-
gigen Farbe (siehe Abbildung in Abschnitt 3.5). Außerdem werden die Schichten der zu bearbeitenden 
Karte im Fenster Karteninhalt aufgelistet. Schließlich erkennt man den Landkarten-Modus daran, dass 
der Symbolschalter  für den Wechsel in den Layout-Modus verfügbar ist. Man kann die Bearbeitung 
einer Karte auch per Mausklick auf eine Arbeitsblattposition außerhalb der Landkartenbox beenden und 
dabei den Layout-Modus aktivieren. 
 

3.9 Arbeitsplatz umgestalten 

Sie können den im RegioGraph-Anwendungsfenster verfügbaren Platz nach eigenen Wünschen aufteilen. 
Die per Voreinstellung am linken Rand angedockten Subfenster (Karteninhalt, Projektverwaltung und 
Kartenbibliothek) lassen sich u.a. ... 

http://www.gfk-geomarketing.de/software/downloads/arbeitsblattvorlagen.html�
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 per Maus an der Titelzeile packen und verschieben 
 vom frei beweglichen Zustand aus an jeder beliebigen Seite des RegioGraph-Fensters andocken 
 per Doppelklick auf die Titelzeile in den vorherigen Zustand (angedockt oder beweglich) zurück ver-

setzen 
 über das Ansicht-Menü aus- oder einschalten 
 im angedockten Zustand über den Symbolschalter  zum automatischen Verschwinden zwingen 

bzw. über den Schalter  zur normalen Permanenz überreden 

Zur Not stellt der folgende Menübefehl wieder einen geordneten Zustand her: 

Ansicht > Standard wiederherstellen 

 
Arbeitsblätter und Tabellen (siehe unten) belegen beim Öffnen den gesamten Dokumentenbereich des 
RegioGraph-Fensters, können aber über das Fenster-Menü bzw. die Schaltfläche  auch in Subfenster 
gesteckt werden, wie es im folgenden Beispiel für ein Arbeitsblattfenster und ein Tabellenfenster zu 
sehen ist: 

 
 
Über den Menübefehl 

Ansicht > Zoom Arbeitsblatt 

bzw. über das Symbolleisten-Steuerelement  lässt sich ein Vergrößerungs- oder Verkleine-
rungsfaktor für das aktive Arbeitsblatt einstellen. 
 
Auch die normalerweise unter dem Hauptmenü stationierten Symbolleisten (Standard, Kartenfunkti-
onen, Formatieren usw.) kann man losreißen, verschieben und (z.B. per Doppelklick auf die Titelzei-
le) erneut andocken. 
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Nach einem rechten Mausklick auf eine freie Stelle in der Symbolleistenzone des Anwendungsfensters 
erscheint ein Menü, mit dem sich die RegioGraph-Symbolleisten sowie eine (anfangs leere) Leiste mit 
Erweiterungen ein- bzw. ausschalten lassen: 

 
Außerdem ist hier eine Dialogbox zum Konfigurieren der Symbolleisten verfügbar. 
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4 Gestaltungsmöglichkeiten im Layout-Modus 
In diesem Abschnitt geht es um die graphische Gestaltung eines Arbeitsblatts, das neben Landkarten noch 
diverse andere Objekte aufnehmen kann. RegioGraph besitzt neben seinen Kernkompetenzen als (Busi-
ness-)GIS auch die grundlegende Funktionalität eines Grafikprogramms. 
 

4.1 Seitenformat ändern 

Nach dem Menübefehl 

Datei > Seite einrichten 

oder nach einem Mausklick auf den per Symbolleisten-Konfiguration (siehe Abschnitt 3.9) nachrüstbaren 
Schalter  kann das Seitenformat des aktiven Arbeitsblatts in der folgenden Dialogbox verändert wer-
den: 

 
Die letzte Wahl dient als Voreinstellung für neue Arbeitsblätter. Mit dem Schalter  kann man zwischen 
Hoch- und Querformat wechseln. 
 

4.2 Bearbeitungen zurücknehmen bzw. wiederherstellen 

Im Layout-Modus können die meisten Modifikationen mit dem Menübefehl 

Bearbeiten > Rückgängig 

oder mit dem Schalter  oder mit der Tastenkombination Strg+Z rückgängig gemacht bzw. mit dem 
Menübefehl 

Bearbeiten > Wiederherstellen 

oder mit dem Schalter  oder mit der Tastenkombination Strg+Y wiederhergestellt werden (auch mehr-
stufig). 
 

4.3 Neue Grafikobjekte einfügen 

Über das Einfügen-Menü können Sie diverse Grafikobjekte einfügen: 

  Linie 

Jeder Mausklick ergibt eine Ecke des Linienzugs. Die Fertigstellung wird per Doppelklick ange-
fordert. 

  Polygon 
Jeder Mausklick ergibt eine Ecke des Polygons. Die Fertigstellung (mit dem automatischen 
Schließen der Figur) wird per Doppelklick angefordert. 
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  Ellipse 

Wenn Sie die Umschalttaste 
 

  drücken, während Sie per Mausklick die linke obere Ecke der 

Figur festlegen, resultiert beim anschließenden Ziehen der Maus (mit gedrückter linker Maustaste) 

ein Kreis. Größe und Seitenverhältnis einer fertigen Ellipse lassen sich über acht Ziehpunkte än-

dern: 

 

  Rechteck 
Mit Hilfe der Umschalttaste 

 

  erhält man ein Quadrat (siehe Beschreibung zur Ellipse). 

  gerundetes Rechteck 
Mit Hilfe der Umschalttaste 

 

  erhält man ein Quadrat mit gerundeten Ecken (siehe Beschrei-

bung zur Ellipse). Über einen speziellen Ziehpunkt lässt sich der Rundungsgrad einstellen: 

 

  Textfeld 
Von dieser Möglichkeit wollen wir im Rahmen des Übungsprojekts Gebrauch machen. Platzieren 
Sie eine Textbox in Titelposition und tragen Sie als Text ein: Verkehrssicherheit 2006. Um eine 
passende Schriftart und den überflüssigen Rahmen der Textbox kümmern wir uns später. Wenn 
Sie einen vorhandenen Text ändern wollen, müssen Sie einen Doppelklick darauf setzen. 

  Grafik aus Datei 
Wenn Sie diese Option wählen, müssen Sie zunächst einen Rahmen auf dem Arbeitsblatt festgele-
gen. Dann können Sie eine Grafikdatei öffnen, wobei folgende Formate unterstützt werden: BMP, 
JPG, EMF, WMF, GIF, TIF, PNG, PCD, PCX. 

  Grafik aus der Palette 
Wenn Sie diese Option wählen, müssen Sie zunächst einen Rahmen auf dem Arbeitsblatt festgele-
gen. Dann können Sie im folgenden Fenster ein Symbol aussuchen und mit OK in den Rahmen 
befördern: 

 
Per Kontextmenü lassen sich Symbole hinzufügen, löschen und einstellen. Unterstützte 
Dateiformate beim Hinzufügen: BMP, JPEG; EMF, WMF, GIF, TIFF, PNG, PCX, PDC. 
Im Einstellen-Dialog lassen sich folgende Eigenschaften eines Symbols ändern: 

 die variable Farbe (relevant für die Verwendung eines Symbols zur Daten-Visualisierung) 
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 die transparente Farbe (relevant bei Bitmap-Formaten) 

 
 Hot Spot für die Lokalisierung des Symbols über einem darzustellenden Zielpunkt 

 
Von der Hersteller-Webseite 

http://www.gfk-geomarketing.de/software/downloads/zusaetzliche_symbole.html 

können zusätzliche Symbole zur Verwendung mit RegioGraph herunter geladen werden. Man er-
hält die Datei palette.pal mit einer im Vergleich zur Originalausstattung erweiterten Liste von 
Symbolen. Diese Datei kann über den Menübefehl 

Format > Palette 

mit Gültigkeit für die aktuelle RegioGraph-Sitzung an Stelle der vorherigen Palette geladen wer-
den. Mit demselben Menü kann man die aktuelle Palette speichern oder die Standardpalette reak-
tivieren. Eine individualisierte Palette von bleibendem Wert muss vor dem Verlassen von Regio-
Graph bzw. vor dem Laden einer anderen Palette gespeichert werden. Das Ändern der Standardpa-
lette erfordert Administratorrechte. Um ein Symbol aus einer Palette zu entnehmen und in einem 
anderen Kontext zu verwenden (z.B. in eine andere Palette aufzunehmen), kann man so vorgehen: 

 Symbol im Layout-Modus auf ein Arbeitsblatt einfügen 
 Eingefügtes Symbol markieren und in die Windows-Zwischenablage befördern 
 Symbol in einem geeigneten Programm (z.B. MS-Powerpoint) aus der Zwischenablage ent-

nehmen und in eine Datei vom Typ EMF speichern 

  Ole-Objekt 
Nach dem Aufziehen eines Rahmens wählt man den Objekttyp: 

http://www.gfk-geomarketing.de/software/downloads/zusaetzliche_symbole.html�
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  Landkarte 
Wenn Sie auf diese Weise eine Landkartenbox auf das Arbeitsblatt bringen, können Sie später aus 
der Projektverwaltung oder der Kartenbibliothek Layer ergänzen. 

 

4.4 Grafikobjekte markieren 

RegioGraph bietet die üblichen Methoden, um Grafikobjekte bei aktivem Standardwerkzeug  für eine 
anschließende (gemeinsame) Bearbeitung (z.B. Verschieben, Löschen) zu markieren: 

 Ein einzelnes Objekt markiert man per Mausklick. 

 Bei gedrückter Umschalttaste 
 

  kann man kumulierend mehrere Objekte per Mausklick markieren. 

 Bei gedrückter Maustaste kann man einen Rahmen um alle zu markierenden Objekte ziehen. 
 Per Mausklick auf eine freie Arbeitsblattstelle hebt man die aktuellen Markierungen auf. 

 

4.5 Grafikobjekte bearbeiten 

4.5.1 Größe und Position 

Grafikobjekte, wozu auch die Landkartenboxen gehören, lassen sich im Layout-Modus auf Windows-
übliche Weise verschieben, verkleinern, vergrößern oder entfernen. Zum Löschen kann man die Entf-
Taste, den per Symbolleisten-Konfiguration (siehe Abschnitt 3.9) nachrüstbaren Symbolschalter  oder 
das Kontextmenü verwenden. 
 

4.5.2 Attribute 

Über das Format-Menü kann man den Formatieren-Dialog anfordern und in Abhängigkeit vom Typ 
der markierten Objekte verschiedene Attribute ändern: 

  Füllung 
Zur Gestaltung von Flächen stehen Farben, Farbverläufe, Muster und Texturen zur Verfügung: 
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Für eine Farbe oder einen Farbverlauf lässt sich der Transparenzgrad einstellen. 
Man ist nicht auf die angezeigte Farbpalette beschränkt, sondern kann nach einem Rechtsklick auf 
eine Farbzelle auch neue Töne kreieren: 

 
Wählen Sie bitte den folgenden Farbverlauf für die Box mit der Deutschlandkarte, wobei die End-
farben nach einem Mausklick auf die entsprechende Musterfläche  zu beeinflussen sind: 

 
Man übernimmt eine Gestaltung per Mausklick auf das grüne Häkchen in der unteren rechten 
Ecke. 

  Linie 
Wählen Sie in der Formatieren-Dialogbox für den Rahmen um die (zuvor markierte) Überschrift 
eine Unsichtbare Linie, indem Sie diese Option markieren und dann auf das grüne Häkchen in 
der unteren rechten Ecke klicken: 

 
Bei den vorgegebenen Linientypen kann man die Breite und eine Farbe über die Werkzeuge am 
unteren Rand des Dialogs ändern, z.B.: 
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Weitaus mehr Gestaltungsmöglichkeiten bietet der folgende, über die Kontextmenüoption Li-
nieneigenschaften ändern erreichbare Dialog: 

 
Ein Typ besteht aus maximal drei gestapelten Linien, die sich einzeln gestalten lassen. Über die 
Registerkarte Linienenden lassen sich z.B. Pfeilspitzen anbringen. Statt einen vorhandenen Li-
nietyp zu ändern, kann man auch einen neuen Typ per Kontextmenü anlegen und dann gestalten. 

  Schriftart 
Wählen Sie im Demoprojekt für die Überschrift die Schriftart Arial, den Stil Fett Kursiv, den 
Schriftgrad 40 sowie die Textfarbe Schwarz: 

 
Über den Menübefehl 

Format > Textausrichtung 

können Sie den Text innerhalb seiner Box horizontal und/oder vertikal ausrichten: 

 
Mit dem Menübefehl 

Format > Ausrichten, Verteilen, Größe > Horizontal auf dem Arbeitsblatt zentrieren 
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erreicht man das horizontale Zentrieren der gesamten Textbox. 

  Schatten 
Wählen Sie für die Landkartenbox im Demoprojekt einen blauen Schatten: 

 
 
Nach dem Ergänzen und Formatieren eines Untertitels und einer Fußnote sollte das erste Arbeitsblatt des 
Demoprojekts ungefähr so aussehen: 

Baden-Württemberg

Hessen

Rheinland-Pfalz

Saarland

Schleswig-Holstein

Hamburg

Niedersachsen

Bremen

Nordrhein-Westfalen

Thüringen

Sachsen-Anhalt

Sachsen

Berlin

Brandenburg

Mecklenburg-Vorpommern

Bayern

Verkehrssicherheit 2006
(Unfalltote pro 1 Million Einwohner)

Quelle: Statistisches Bundesamt

 
In der Symbolleiste Schnellformat sind wichtige Formatierungsoptionen besonders leicht erreichbar, 
z.B. 
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Über den bereits im Zusammenhang mit Symbolen (siehe Abschnitt 4.3) behandelten Menübefehl 

Format > Palette 

kann man die aktuelle Palette mit allen Eigenkreationen (z.B. Farben, Linientypen) speichern oder eine 
zuvor gespeicherte Palette laden. Ohne explizites Speichern gehen die Änderungen und Erweiterungen 
der Palette beim Beenden von RegioGraph verloren. 
 

4.5.3 Eigenschaftsdialog 

Größe, Position und Attribute eines Objekts lassen sich auch über seinen Eigenschaftsdialog ändern, der 
via Kontextmenü erreichbar ist, z.B. bei einer Landkartenbox: 

 
 

4.5.4 Linien und Polygone editieren 

Bei einfachen Linien (nur ein Segment) lassen sich die Endpunkte per Maus anpacken und verschieben. 
Gehen Sie folgendermaßen vor, um eine Polylinie oder ein Polygon zu ändern: 

 Markieren Sie das zu verändernde Objekt. 
 Bei gedrückter Taste S können Sie einen Stützpunkt verschieben. 
 Bei gedrückter Taste A können Sie einen zusätzlichen Stützpunkt einfügen. 
 Bei gedrückter Taste D können Sie einen Stützpunkt löschen. 
 

4.5.5 Übertragung von Formaten 

Um die Formatattribute eines Quellobjekts (Hintergrundfarbe, Schatten, Linientyp etc.) auf ein Zielobjekt 
zu übertragen (sofern dort anwendbar), geht man folgendermaßen vor: 

 Quellobjekt markieren 
 Mit dem Menübefehl Format > Format Übertragen das Übertragungswerkzeug  aktivieren 
 Linker Mausklick auf das Zielobjekt 
 

4.5.6 Objektstapelung verändern 

Sukzessiv am selben Ort erzeugte Objekte liegen in natürlicher Anordnung übereinander und überdecken 
sich dabei (teilweise). Mit dem Menübefehl 

Format > Reihenfolge 

kann ein markiertes Zeichnungselement im Stapel nach oben bzw. unten verschoben werden. 
 
In diesem Zusammenhang bietet der für alle Flächen einstellbare Transparenzgrad interessante Gestal-
tungsmöglichkeiten, z.B.: 
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4.6 Anpassungsmaßnahmen 

4.6.1 Grafikobjekte an einem Referenzobjekt ausrichten 

Über den Menübefehl  

Format > Ausrichten, Verteilen, Größe 

können Sie für eine Gruppe von simultan markierten Objekten dafür sorgen, dass alle ihre Position am 
zuletzt markierten Objekt orientieren: 

  Linksbündig 

  Rechtsbündig 

  Oben ausrichten 

  Unten ausrichten 

  Horizontal zentrieren 

  Vertikal zentrieren 

 

4.6.2 Zentrieren in Bezug auf das Arbeitsblatt 

Mit dem Menübefehl 

Format > Ausrichten, Verteilen, Größe 

können Sie Grafikobjekte in Bezug auf das Arbeitsblatt horizontal oder vertikal zentrieren: 

  Horizontal auf dem Arbeitsblatt zentrieren 

  Vertikal auf dem Arbeitsblatt zentrieren 

 

4.6.3 Grafikobjekte verteilen 

 Über den Menübefehl  

Format > Ausrichten, Verteilen, Größe 

können Sie für eine Gruppe von simultan markierten Objekten dafür sorgen, dass der Abstand vom ersten 
bis zum letzten Objekt in horizontaler oder vertikaler Richtung gleichmäßig aufgeteilt wird: 

  Horizontal verteilen 
Die Objekte am linken und rechten Rand der Gruppe behalten ihre Position. Alle anderen verän-
dern ihre horizontale Position so, dass die horizontalen Abstände zwischen allen Objekten gleich 
werden. 
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  Vertikal verteilen 
Die Objekte am oberen und unteren Rand der Gruppe behalten ihre Position. Alle anderen verän-
dern ihre vertikale Position so, dass die vertikalen Abstände zwischen allen Objekten gleich wer-
den. 

 

4.6.4 Größe anpassen 

Über den Menübefehl  

Format > Ausrichten, Verteilen, Größe 

können Sie für eine Gruppe von simultan markierten Grafikobjekten dafür sorgen, dass alle ihre Größe an 
das zuletzt markierte Objekt anpassen: 

  Gleiche Breite 

  Gleiche Höhe 

  Gleiche Höhe / Breite 

 

4.7 Grafikobjekte gruppieren 

Grafikobjekte, die (vorübergehend) gemeinsam behandelt (z.B. verschoben) werden sollen, steckt man 
am besten in eine Gruppe. Dazu markiert man alle Gruppenmitglieder und wählt dann den Menübefehl: 

Bearbeiten > Gruppieren > Gruppieren 

Um eine markierte Gruppe wieder in ihre Einzelbestandteile zu zerlegen, wählt dann den Menübefehl: 

Bearbeiten > Gruppieren > Gruppierung aufheben 

Alternativ kann man die per Symbolleisten-Konfiguration (siehe Abschnitt 3.9) nachrüstbaren Schalter 
 bzw.  verwenden. 
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5 Landkartenbearbeitung 
In diesem Abschnitt werden Techniken zur Kartenbearbeitung beschrieben, die unabhängig von den dar-
zustellenden Tabellendaten durchgeführt werden (z.B. Gebiete ausblenden, Maßstab ändern, Beschriftun-
gen der geografischen Objekte anpassen). Diese Maßnahmen dienen meist zur Vorbereitung der Karten-
grundlage für die anschließenden Merkmalsvisualisierungen. Um vom Layout- in den Kartenbearbei-
tungsmodus zu gelangen, setzt man einen Doppelklick auf die zu bearbeitende Karte. 
 

5.1 Tipps zur Vermeidung von Ärger 

Im Kartenbearbeitungsmodus ist der Menübefehl Bearbeiten > Rückgängig nicht immer wirksam. 
Z.B. kann das Verschieben einer Karte mit dem  -Werkzeug (siehe unten) nicht rückgängig gemacht 
werden. Bei Beachtung der folgenden Tipps sollte die Landkartenbearbeitung aber trotzdem ohne großen 
Ärger verlaufen: 
 
Glücklich, wer beizeiten sichert! 

Wer vor jeder kritischen Kartenbearbeitung den aktuellen Zustand sichert, hat eine einfache Möglichkeit, 
misslungene Änderungen rückgängig zu machen: 

 Projekt schließen ohne Sichern 
 Projekt neu öffnen 

Das regelmäßige Sichern (z.B. alle 15 Minuten) ist generell empfehlenswert, zumal RegioGraph keine 
automatischen Sicherungen vornimmt. 
 
Die Geister, die ich rief ... 

Bei den im Abschnitt 5 beschriebenen Verfahren wird in der Regel ein spezieller Bearbeitungsmodus 
eingeschaltet, der u.a. durch eine spezielle Funktion und eine spezielle Gestalt des Mauszeigers gekenn-
zeichnet ist. Z.B. hat im Verschiebungsmodus der Mauszeiger die Gestalt , und jede Mausbewegung 
bei gedrückter linker Maustaste verschiebt die Karte (ohne Möglichkeit zur Rücknahme). Gelegentlich ist 
es sinnvoll, einen speziellen Bearbeitungsmodus zu beenden, um unbeabsichtigte Mauseffekte zu vermei-
den. Dazu reaktiviert man per Mausklick das Standardinstrument , das als unbeabsichtigte Aktion ledig-
lich eine (leicht reversible) Markierung verursachen kann. 
 
Kleiner Schalter, große Wirkung 

Bei aufwändigen Landkartenbearbeitungen schafft es RegioGraph nicht immer, die Bildschirmanzeige 
aller Details auf aktuellem Stand zu halten. Daher ist es gelegentlich nötig, die Anzeige mit dem Schalter 

 (Symbolleiste Standard) zu aktualisieren. 
 

5.2 Karteninhaltsfenster und Arbeitslayer 

Mit dem Landkartenmodus wird auch das Fenster Karteninhalt  aktiv und zeigt alle Schichten der aktu-
ellen Karte an. Da unsere Karte derzeit nur eine Schicht enthält, übernehmen wir der Übung halber aus 
der Kartenbibliothek noch die Schicht Städte über 100.000 Einwohner in die Projektverwaltung und 
die Karte. 
 
Es kann jeweils nur ein Layer bearbeitet werden. Dieser Arbeitslayer wird im Karteninhaltsfenster mar-
kiert (invers) dargestellt. Durch einen Klick auf den entsprechenden Eintrag im Karteninhaltsfenster ma-
chen wir Bundesländer Deutschland 2008 zum Arbeitslayer: 
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Um eine Schicht aus der aktuell bearbeiteten Karte (nicht aus dem Projekt) zu entfernen, wählt man aus 
ihrem Kontextmenü im Karteninhaltsfenster die Option Entfernen. Über das Kontrollkästchen links 
neben ihrem Namen lässt sich eine Schicht aus- bzw. einblenden. Eine unsichtbare Schicht bleibt in der 
Karte mit ihren spezifischen Einstellungen (z.B. Ein- und Ausblendungen, Maßstab) erhalten, während 
eine entfernte Schicht bei einer späteren Neuaufnahme keine Erinnerung mehr an ihren früheren Einsatz 
in der Karte hat. 
 
Es kann durchaus sinnvoll sein, eine Schicht mehrfach auf eine Karte zu legen, um auf den einzelnen 
Schichten verschiedene Visualisierungstechniken einzusetzen (siehe unten). 
 
Die für den Gesamteindruck der Karte sehr wichtige Reihenfolge der Schichten kann in der Layer-
kontrolle durch Ziehen und Ablegen mit der Maus geändert werden. 
 
Über die Option Eigenschaften im Kontextmenü zum Arbeitslayer lässt sich eine Tabelle (des)aktivie-
ren, mit der sich das Verhalten des Arbeitslayers auf vielfältige Weise beeinflussen lässt, z.B.: 

 
Die Werte der Quickinfospalten werden im Landkarten-Modus angezeigt, sobald der Mauszeiger bei 
aktiver Quickinfo-Anzeige über einem geographischen Objekt verweilt, z.B.: 

 
Aktivieren läst sich die Quickinfo-Anzeige (im Landkarten-Modus) über den Menübefehl 

 Landkarte > Quickinfo anzeigen  

oder den Schalter  in der Leiste Kartenfunktionen. 
 
Mit der Eigenschaft Objekte zeigen wird festgelegt, in welchem Maßstabsbereich eine Schicht ange-
zeigt werden soll. Analog lässt sich die Anzeige der Objektbeschriftungen vom Maßstab der Karte ab-
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hängig machen. Für die Städteschicht wird im Beispiel eingestellt, dass die Beschriftungen nur bei einem 
Maßstab kleiner oder gleich 1:500.000 erscheinen sollen. 
 
Durch Mausklicks bei gedrückter Strg-Taste legt man im Karteninhaltsfenster Infolayer fest, deren Ob-
jekte bei den in Abschnitt 5.8 beschriebenen Informationsmethoden zusätzlich zu den Arbeitslayer-
Objekten berücksichtigt werden sollen, z.B.: 

 
 
Mit der Erstellung neuer, leerer Layer beschäftigen wir uns in Abschnitt 5.13. 
 

5.3 Ausschnitt definieren 

Wir sorgen zunächst für eine lesbare Beschriftung der Gebiete: 

 Machen Sie Bundesländer Deutschland 2008 zum Arbeitslayer. 

 Öffnen Sie den Schriftformatierungsdialog mit dem Menübefehl 

Format > Schrift 

oder mit dem Steuerelement1  in der Symbolleiste Format. 

 Wählen Sie folgende Schriftattribute: 

 
 Übernehmen Sie die Einstellungen durch einen Klick auf das grüne Häkchen in der rechten unteren 

Ecke des Dialogs. 
 
Nun kommen wir zum eigentlichen Thema des aktuellen Abschnitts. Aktivieren Sie über den Menübefehl 

Landkarte > Zoom + 

oder mit dem positiven Zoom-Symbol  auf der Symbolleiste Kartenfunktionen das Ausschnitts-
werkzeug , und wählen Sie einen Ausschnitt, der nur die neuen Bundesländer umfasst: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit Attributkategorien, und die zuletzt benutzte Option ist im 

Steuerelement direkt anwählbar, z.B. . 
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en

Schleswig-Holstein

Hamburg

iedersachsen

n

Thüringen

Sachsen-Anhalt

Sachsen

Berlin

Brandenburg

Mecklenburg-Vorpommern

 
Während Sie per Maus das Ausschnittsrechteck festlegen, werden seine Seitenlängen in der Statuszeile 
angezeigt (in km). 
 
Die Zoom-Funktion lässt sich natürlich auch auf bereits vergrößerte Ausschnitte anwenden. Wählen Sie 
so einen Ausschnitt, der nur Brandenburg und Berlin umfasst. 
 
Wechseln Sie über den Menübefehl 

Landkarte > Zoom - 

oder mit einem Mausklick auf das negative Zoom-Symbol  (Symbolleiste Kartenfunktionen) zurück 
zur letzten Zoom-Stufe (neue Bundesländer). 
 
Nach einer Ausschnittsveränderung macht man gern von der RegioGraph-Option Gebrauch, eine Karte 
mit dem -Werkzeug unter dem Kartenfenster zu verschieben. 
 
Die in diesem Abschnitt beschriebenen Methoden verändern eine Landkartenbox, indem sie die geogra-
phischen Koordinaten der linken oberen Kartenecke sowie den Maßstab neu festlegen. Im Unterschied 
dazu wird über den in Abschnitt 3.9 vorgestellten Menübefehl 

Ansicht > Zoom Arbeitsblatt 

bzw. über das Steuerelement  auf der Standard-Symbolleiste lediglich die Anzeige des Ar-
beitsblatts beeinflusst. 
 

5.4 Geographische Objekte auswählen 

Viele Arbeiten im Landkartenmodus (z.B. Ausblenden von Objekten, Formatieren der Beschriftung) sol-
len nur für bestimmte Objekte ausgeführt werden. Daher bietet RegioGraph zahlreiche Werkzeuge zum 
Markieren von Objekten. Machen Sie nötigenfalls im Demoprojekt die Bundesländerschicht zum Arbeits-
layer, wählen Sie einen Kartenausschnitt mit den westlichen Bundesländern, aktivieren Sie das Standard-
instrument  zum Markieren einzelner Objekte über den Menübefehl 
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Bearbeiten > Auswählen > Auswählen 

oder das zugehörige Symbol auf der Standard-Leiste, und klicken Sie nacheinander bei gedrückter Um-

schalttaste 
 

  auf die Bundesländer Rheinland-Pfalz und Hessen. Das Ergebnis: 

 
Bei gedrückter linker Maustaste kann man ein Rechteck aufziehen, um alle (mit einem wesentlichen Flä-
chenanteil) tangierten Gebiete auszuwählen. 
 
Um die Markierung eines Gebietes aufzuheben, klickt man es mit dem Standardinstrument  erneut an. 
Sollen dabei die Markierungen anderer Gebiete erhalten bleiben, ist zusätzlich die Umschalttaste zu drü-
cken. 
 
Über den Menübefehl 

Bearbeiten > Auswählen 

bzw. über das Steuerelement1  auf der Symbolleiste Standard sind noch andere Möglichkeiten ver-
fügbar, geographische Objekte für die weitere Bearbeitung zu markieren: 

  Auswählen mit Kreis 

  Auswählen mit Polygon 

  Alles auswählen Strg+A 

  Auswahl aufheben Strg+M 

  Auswahl umkehren 

 
Die beschriebenen Markierungstechniken können in Schichten beliebigen Typs auf die dortigen Objekte 
angewendet werden. 
 
Nach dem Menübefehl 

Landkarte > Selektion 

können Sie mit Hilfe der folgenden Dialogbox alle Objekte markieren, die einer Bedingung genügen: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den anschließend beschriebenen Optionen. Die zuletzt be-

nutzte Option ist im Steuerelement direkt anwählbar. 
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Im Beispiel werden die ganz neuen Bundesländer und das ebenfalls etwas später dazu gekommene Saar-
land markiert. 
 
Wie man das Tabellenfenster einer Schicht zum Markieren von geographischen Objekten verwendet, er-
fahren Sie in Abschnitt 7.2.2. 
 

5.5 Landkarte einpassen 

RegioGraph kann die markierten Objekte oder die gesamte Karte optimal in die Landkartenbox einpas-
sen, wobei die Karte verschoben und ein geeigneter Maßstab gewählt wird. Markieren Sie das Bundes-
land Brandenburg, und fordern Sie die optimale Einpassung über den Menübefehl 

Landkarte > Einpassen > Ausgewählte Objekte einpassen 

oder das Steuerelement1  auf der Symbolleiste Kartenfunktionen an. Das Ergebnis: 

 
Passen Sie die gesamte Karte ein mit: 

Landkarte > Einpassen > Landkarte einpassen 

Dieses Kommando bietet offenbar eine Möglichkeit, alle Ausschnittsveränderungen in einem Schritt 
rückgängig zu machen. 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü, das auch die Einpassung des Arbeitslayers oder der gesamten 

Karte erlaubt. Die zuletzt benutzte Option ist im Schalter direkt anwählbar. 
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5.6 Aus- und Einblenden von geographischen Objekten 

Oft werden Sie die Objekte einer RegioGraph-Kartenschicht nur teilweise verwenden wollen, z.B. vom 
Gebietslayer Bundesländer Deutschland 2008 nur die neuen Bundesländer: 

Thüringen

Sachsen-Anhalt

Sachsen

Berlin

Brandenburg

Mecklenburg-Vorpommern

 
Um solche Effekte zu erreichen bzw. zu entfernen, blendet man im Arbeitsblatt- oder im Tabellenfenster 
(siehe unten) einzelne Objekte aus- bzw. ein. Im Landkartenmodus sind über den Menübefehl 

Landkarte > Ein-/Ausblenden 

und den korrespondierenden Schalter1  folgende Optionen verfügbar: 

  ausblenden 
Alle markierten Objekte werden ausgeblendet. 

  einblenden 
Alle markierten Objekte werden eingeblendet. Da ausgeblendete Objekte auf der Karte nicht mehr 
zu sehen sind, klappt das Markieren zum anschließenden Einblenden am besten im Tabellenfens-
ter (siehe Abschnitt 7.2.2). 

  alles einblenden 
Alle Objekte werden eingeblendet. 

  alles ausblenden außer 
Alle Objekte mit Ausnahme der markierten werden ausgeblendet. 

 

5.7 Beschriftungen anpassen 

Über den Menübefehl 

Landkarte > Beschriftung 

bzw. Symbole auf der Beschriftungs-Symbolleiste können Sie die Beschriftung der markierten geogra-
phischen Objekte in der aktiven Schicht festlegen: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den anschließend beschriebenen Optionen. Die zuletzt be-

nutzte Option ist im Schalter direkt anwählbar. 
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  Beschriftung einblenden 
  Beschriftung ausblenden 
  Beschriftung einstellen 

Im folgenden Dialog kann man die Position der Beschriftungen relativ zum Zielpunkt wählen, was 
besonders bei Punkteschichten relevant ist: 

 
Bei der Einstellung Frei verschiebbar werden zuvor manuell veränderte Positionen (siehe un-
ten) beim Quittieren der Dialogbox respektiert und nicht (wie bei den anderen Varianten) durch 
Standardwerte ersetzt. 
Außerdem kann man den Schriftwinkel einstellen und die relative Ausrichtung von mehrzeiligen 
Ausgaben regeln. 

  Beschriftungsspalten wählen 
Aus der Liste mit allen Variablen der zur aktiven Schicht gehörigen Tabelle dürfen die einzublen-
den Informationen gewählt werden, z.B.: 

 

  Beschriftungen automatisch anordnen 
Wird die folgende Dialogbox bei einer aktiver Punkteschicht mit OK quittiert, 

 
dann werden z.B. überlappende Beschriftungen (samt zugehörigen Punkten) ausgeblendet. 

 
Durch vorheriges Markieren lässt sich eine Beschriftungsmaßnahme auf bestimmte Objekte beschränken. 
 
RegioGraph produziert per Voreinstellung sehr kleine Beschriftungen, vermutlich zur Vermeidung von 
Überschneidungen. Über den Menübefehl Format > Schrift bzw. mit dem Steuerelement1  in der 
Symbolleiste Format kann man für die Beschriftungen der (markierten Objekte in der) aktiven Schicht 
eine angemessene Schriftart einstellen, was wir bereits in Abschnitt 5.3 getan haben. 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit Attributkategorien, und die zuletzt benutzte Option ist im 

Steuerelement direkt anwählbar. 



 

AWS.RG.3: 11. November 2009 35 

Thematische Kartographie mit RegioGraph 10 
 
 
So können Sie die Beschriftung eines geographischen Objekts auf dem Arbeitslayer verschieben: 

 Aktivieren Sie nötigenfalls das Standardwerkzeug . 
 Halten Sie die Strg-Taste gedrückt. 
 Verschieben Sie die Beschriftung mit der linken Maustaste. 

 
Speziell bei Linienschichten ist die Option von Interesse, Beschriftungen zu drehen, z.B.: 

Rhein

M
os

el

K
yl

l

Ahr

20 km

 

Dies ermöglicht das Standardwerkzeug , wenn die Strg- und die Umschalttaste 
 

  gedrückt sind. 
 

5.8 Informationen zu geographischen Objekten abrufen 

Die Tabelle zu einer Kartenschicht enthält zu jedem geographischen Objekt verschiedene Informationen 
(mindestens eine Kennung und/oder eine Bezeichnung). Über den Menübefehl 

Landkarte > Infos abrufen 

bzw. über das Steuerelement1  in der Symbolleiste Kartenfunktionen kann man den Infomodus in 
Verbindung mit unterschiedlichen Auswahl-Werkzeugen aktivieren, um anschließend Informationen zu 
den Objekten des Arbeitslayers abzurufen. Wurden im Karteninhaltsfenster durch Mausklick bei gedrück-
ter Strg-Taste zusätzliche Infolayer gewählt, werden deren Objekte einbezogen. 

  Infos abrufen 
Anschließend kann man per Mausklick auf ein geographisches Objekt der aktiven Schicht ein 
Fenster mit seinen Daten abrufen, z.B. (Bundesländer als Arbeitslayer, kein weiterer Infolayer): 

 
Bei gedrückter Umschalttaste kann man mehrere Objekte kumulierend markieren. Zieht man per 
Maus ein Auswahlrechteck auf, dann erscheinen Informationen zu allen angesprochenen Objek-
ten. Offenbar nimmt RegioGraph ein Gebiet in die Tabelle auf, wenn ein wesentlicher Anteil sei-
ner Fläche im Auswahlrechteck liegt. 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den anschließend beschriebenen Optionen. Die zuletzt be-

nutzte Option ist im Schalter direkt anwählbar. 
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  Infos abrufen mit Kreis 
Anschließend kann man über einen Auswahlkreis ein Fenster mit den Daten zu allen angespro-
chenen Objekten der Infolayer anfordern, z.B.: 

 
Offenbar nimmt RegioGraph ein Gebiet in die Tabelle auf, wenn ein wesentlicher Anteil seiner 
Fläche im Auswahlkreis liegt. 
Die statistischen Berechnungen im unteren Teil der Ausgabe erhält man über den Schalter  
(Layerstatistik ein/aus). 

  Infos abrufen mit Polygon 
Anschließend kann man durch freihändiges Abgrenzen einer beliebigen Zone die Daten zu allen 
darin befindlichen Objekten der Infolayer anfordern. Wie bei der Kreisauswahl wird ein Gebiet 
aufgenommen, sobald ein wesentlicher Anteil seiner Fläche in der Auswahlzone liegt. 

  Objekte im Gebiet 
Ist der Arbeitslayer eine Gebietsschicht, erhält man Informationen zu allen Infolayer-Objekten des 
gewählten Gebiets, z.B. (Bundesländer als Arbeitslayer, Städte als Infolayer): 

 
Hier wurden die beiden Fensterteile mit dem Schalter  untereinander angeordnet. 

  Objekte im Umkreis 
Anschließend kann man per Mausklick Informationen zu allen (Infolayer-)Objekten im Umkreis 
mit einem bestimmten Radius um die Klickstelle abrufen, z.B. (Städte als Arbeitslayer, kein wei-
terer Infolayer): 

 
Wie man den Umkreisradius festlegt, ist gleich zu erfahren. 

  Objekte im Puffer 
Ist ein Linienlayer aktiv, kann man anschließend per Mausklick Informationen zu allen Infolayer-
Objekten in einem Korridor bestimmter Breite um die gewählte(n) Strecke(n) abrufen, z.B.: 
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Wie man die Pufferbreite festlegt, ist gleich zu erfahren. 

  Einstellungen 
Im folgenden Dialog legt man den Radius für die Funktion Objekte im Umkreis sowie die Kor-
ridorbreite für die Funktion Objekte im Puffer fest: 

 
 

5.9 Entfernungen messen 

RegioGraph kann die Entfernung entlang einer Polylinie messen: 

 Wählen Sie den Menübefehl Landkarte > Entfernungen. 
 Klicken Sie auf den Startpunkt, danach auf alle Zwischenstationen und schließlich auf den Zielpunkt. 

Der aktuelle km-Stand wird während der Reise angezeigt, z.B.: 
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5.10 Geographische Orientierungshilfen für Landkarten 

5.10.1 Maßstab eintragen 

Nach dem Menübefehl 

Landkarte > Maßstab 

können Sie mit der folgenden Dialogbox den Maßstab einer Karte verändern und/oder anzeigen lassen: 

 
Auf den im Feld Aktueller Wert sicht- und modifizierbaren Maßstab wirken sich z.B. die Zoom-
Funktion (siehe Abschnitt 5.3) und das Einpassen von Gebieten (siehe Abschnitt 5.5) aus. 
 
Der eingeblendete Maßstab kann mit dem Standardinstrument  markiert und anschließend hinsichtlich 
Position und Größe verändert werden, wobei RegioGraph eine Größenänderung bei der Maßstabsangabe 
berücksichtigt, z.B.: 
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N

70 km

 
Wenn das Einpassen einer Karte bzw. ihrer markierten Objekte nicht zum gewünschten Maßstab führt, 
kann über die numerische Eingabe nachgebessert werden. Im Landkarten-Modus lässt sich der Maßstab 
auch mit dem Rollrad der Maus verändern. 
 

5.10.2 Nordpfeil eintragen 

Nach dem Menübefehl 

Landkarte > Nordpfeil 

können Sie mit der folgenden Dialogbox einen Nordpfeil in die Karte eintragen lassen: 

 
Der eingeblendete Nordpfeil kann mit dem Standardinstrument  markiert und anschließend hinsichtlich 
Position und Größe verändert werden (siehe Abbildung im letzten Abschnitt). 
 

5.10.3 Gitternetz anzeigen 

Nach dem Menübefehl 

Landkarte > Gitternetz 

kann man in der folgenden Dialogbox 
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Gitterlinien mit den Längen- und Breitengraden anfordern, z.B.: 

6°

6°

6° 30'

6° 30'

7°

7°

7° 30'

7° 30'

8°

8°

8° 30'

8° 30'

49°

49°

49° 30'

49° 30'

50°

50°

50° 30'

50° 30'

 
 

5.11 Perspektive wählen 

Über den Menübefehl 

Landkarte > Perspektive 

ist ein Werkzeug zur Wahl der Perspektive verfügbar, wobei im Kontrollgitter zur Orientierung der untere 
Kartenrand rot hervorgehoben ist: 

 
Dieses Werkzeug macht eine Karte nicht unbedingt übersichtlicher, eignet sich aber zur optischen Beto-
nung bestimmter Objekte, z.B.: 
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5.12 Projektion einstellen 

Zur Umrechnung der geographischen Koordinaten, die von der annähernd kugelförmigen Erdoberfläche 
stammen, auf eine zweidimensionale Karte stehen diverse Projektionsmethoden zur Wahl, die sich auf die 
Erhaltung verschiedene Aspekte (z.B. Flächen, Längen, Winkel) konzentrieren. Über den Menübefehl 

Landkarte > Projektion 

lässt sich die Projektion im folgenden Dialog einstellen, z.B.: 
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6°
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6° 30'
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50° 30'
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8° 30'

49°
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49° 30'

49° 30'

50°
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50° 30'

50° 30'

 
 

5.13 Neue Layer anlegen und bearbeiten 

Auf der Basis einer vorhandenen Schicht können neue Layer mit Punkten, Linien, Flächen oder beliebi-
gen Objekten erstellt und anschließend bearbeitet werden. Die Bearbeitungsfunktionen (z.B. geographi-
sche Objekte ergänzen, Darstellung modifizieren) sind auch bei den von RegioGraph mitgelieferten 
Punkte-, Linien- und Flächenlayern anwendbar. 

5.13.1 Punktelayer 

Zum Erzeugen eines neuen Punktelayers startet man den Landkarten-Modus und wählt im Karteninhalts-
fenster aus dem Kontextmenü zu einem vorhanden Layer die Option: 

Neuer Layer > Punkte 

Ist der neue Punktelayer aktiv, kann mit dem Menübefehl 

Einfügen > Punkt 

das Werkzeug  zur Definition neuer Punkte aktiviert werden. Klickt man mit diesem Werkzeug auf 
die gewünschte Position eines neuen Punkts, wird seine Kennung erfragt: 

 
Mit Hilfe dieser Technik wurde die folgende Karte zum Einzugsgebiet des Trierer Weihnachtsmarktes 
auf der Basis der Gebietsschicht Stadt- und Landkreise Deutschland 2008 erstellt: 
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LK Cochem-Zell

LK St. Wendel

LK Birkenfeld

LK Bernkastel-Wittlich

SK Trier

LK Trier-Saarburg

LK Merzig-Wadern

LK Eifelkreis Bitburg-Prüm

LK Vulkaneifel

Cochem

Zell

Sankt Wendel

Idar-Oberstein

Morbach

Konz

Wadern

Merzig

Bitburg Wittlich

Daun
Prüm

Hermeskeil

 
Es wäre möglich gewesen, eine in RegioGraph enthaltene Punkteschicht mit deutschen Städten zu ver-
wenden, die (zahlreichen!) überflüssigen Orte auszublenden und fehlende Punkte zu ergänzen. Stattdes-
sen wurden die gewünschten Orte auf einer eigenen Punkteschicht untergebracht, wobei die exakten Posi-
tionen über die (aus anderer Quelle bekannten) geographischen Koordinaten der Orte festgelegt wurden. 
 
RegioGraph zeigt in der Statuszeile die geographischen Koordinaten des Mauszeigers an, so dass sich mit 
etwas Geduld eine bekannte Position in der Karte ansteuern lässt, um dort einen Punkt zu setzen. Die ge-
wünschte Koordinatendarstellung lässt sich über 

Extras > Optionen > Einheiten 

einstellen, z.B.: 
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Über die Option Eigenschaften im Kontextmenü eines vorhandenen Punkts (per Standardwerkzeug zu 
öffnen) erreicht man die folgende Dialogbox, die eine numerische Positionsbestimmung in Dezimalgra-
den erlaubt: 

 
 
Über 

Datei > Import > Neue Objekte im folgenden Layer erzeugen 

kann man anlog zum Datenimport (vgl. Abschnitt 7.1) beliebig viele Punkte aus einer Datei mit geogra-
phischen Koordinaten oder mit den Kennungen eines Abgleichs-Layers importieren. 
 
Die Objekte eines aktiven Punktelayers lassen sich … 

 bei gedrückter Strg-Taste mit dem Standardwerkzeug  per Maus beliebig verschieben 
Dabei wandert die Beschriftung mit. Es ist auch möglich, ausschließlich die Beschriftung zu bewe-
gen. 

 im markierten Zustand löschen 
 mit einem alternativen Symbol verbinden 

Für alle oder die markierten Punkte kann nach Format > Symbol in folgendem Dialog ein Symbol 
gewählt werden (vgl. Abschnitt 4.3 zur Palette mit Symbolen): 

 
 

5.13.2 Linienlayer 

Zum Erzeugen eines neuen Linienlayers startet man den Landkarten-Modus und wählt im Karteninhalts-
fenster aus dem Kontextmenü zu einem vorhanden Layer die Option: 

Neuer Layer > Linie 

Ist der neue Linienlayer aktiv, kann man mit dem Menübefehl 

Einfügen > Linien 
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das Werkzeug  zur Definition neuer Linien aktivieren und dann durch einfache Mausklicks den Start 
und die Zwischenstationen sowie durch einen Doppelklick den Endpunkt festlegen. Sobald der Schluss-
punkt gesetzt ist, wird die Kennung der neuen Strecke abgefragt, z.B.: 

 
 
Durch Linien können nicht nur geographische Objekte wie Straßen oder Flüsse auf einer Karte repräsen-
tiert werden, sondern z.B. auch Besucherströme. Zugehörige Daten lassen sich dann z.B. durch Typ, Far-
be oder Stärke der Linien visualisieren. 
 
Über 

Datei > Import > Neue Objekte im folgenden Layer erzeugen 

kann man anlog zum Datenimport (vgl. Abschnitt 7.1) beliebig viele Linien aus einer Datei mit geogra-
phischen Koordinaten oder mit den Kennungen eines Abgleichs-Layers importieren. 
 
Gehen Sie folgendermaßen vor, um eine Strecke nachträglich zu verändern: 

 Aktivieren Sie den Landkarten-Modus. 
 Legen Sie den Arbeitslayer passend fest. 
 Aktivieren Sie das Standardwerkzeug. 
 Markieren Sie die zu verändernde Strecke. 
 Bei gedrückter Taste S können Sie einzelne Punkte der Polygonlinie anpacken und verschieben. 
 Bei gedrückter Taste A können Sie per Mausklick auf den Linienverlauf neue Punkte einfügen. 
 Bei gedrückter Taste D können Sie per Mausklick überflüssige Punkte löschen. 
 
Man kann eine Linie … 

 im markierten Zustand bei gedrückter Strg-Taste mit dem Standardwerkzeug  per Maus beliebig 
verschieben 
Dabei wandert die Beschriftung mit. Es ist auch möglich, ausschließlich die Beschriftung zu bewe-
gen, wobei eine vorherige Markierung der Linie nicht erforderlich ist. Außerdem lassen sich die Be-
schriftungen frei drehen (Strg- und Umschalttaste drücken), z.B.: 

 
 im markierten Zustand löschen 
 mit einem alternativen Linientyp verbinden 

Für alle oder die markierten Linien kann nach Format > Linie in folgendem Dialog ein Linientyp 
gewählt und gestaltet werden: 
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5.13.3 Flächenlayer 

Zum Erzeugen eines neuen Flächenlayers startet man den Landkarten-Modus und wählt im Karteninhalts-
fenster aus dem Kontextmenü zu einem vorhanden Layer die Option: 

Neuer Layer > Flächen 

Ist der neue Flächenlayer aktiv, kann man mit dem Menübefehl 

Einfügen > Polygon 

das Werkzeug  zur Definition von neuen Polygonen (Flächen) aktivieren und dann durch Mausklicks 
ein Polygon mit beliebig vielen Zwischenpunkten festlegen. Statt einzelne Punkte anzuklicken, kann man 
auch mit festgehaltener Maustaste einen Grenzverlauf freihändig zeichnen. Nach dem Schließen des Po-
lygons per Doppelklick wird die Kennung der neuen Fläche abgefragt, z.B.: 

 
 
Analog zum Vorgehen bei Linien (siehe Abschnitt 5.13.2) kann man auch Flächen nachträglich modifi-
zieren, verschieben oder löschen. 
 
Hinsichtlich der RegioGraph-Optionen zur kartographischen Darstellung von Daten (siehe unten) gibt es 
keine Unterschiede zwischen Gebieten und Flächen. 
 

5.13.4 Objektelayer 

Wenn freie Objekte wie Pfeile, Anmerkungen etc. einen Bezug zu Landkartenobjekten haben, sollten sie 
nicht im Layout-Modus eingetragen werden, weil dann der Bezug durch Verschieben oder Zoomen der 
Karte verloren geht. In einem solchen Fall erzeugt man besser einen Objektlayer zur Karte und trägt die 
freien Objekte dort ein. 
 
Zum Erzeugen eines neuen Objektelayers startet man den Landkarten-Modus und wählt im Karteninhalts-
fenster aus dem Kontextmenü zu einem vorhanden Layer die Option: 

Neuer Layer > beliebige Objekte 

Ist dieser Layer aktiv, stehen die selben Gestaltungsmöglichkeiten wie im Layout-Modus zur Verfügung 
(z.B. Einfügen von Grafikobjekten, siehe Abschnitt 4.3). 
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Im Weihnachtsmarktbeispiel könnte man einen Objektlayer dazu verwenden, einen Pfeil von der Be-
zeichnung SK Trier bis zum zugehörigen Gebiet zu zeichnen: 

 
Um die markierte Linie bearbeiten zu können, muss man die zuständige Formatieren-Dialogbox even-
tuell über den Menübefehl1 

Format > Füllung 

öffnen und dann die zuständige Registerkarte wählen, z.B.: 

 
 
Auf einen Objektelayer lässt sich über den Menübefehl 

Einfügen > Grafik aus Datei 

auch eine Bitmap-Grafik als Hintergrund montieren, z.B.: 

 

                                                 
1 Vermutlich sorgt bald ein RegioGraph-Servicepack dafür, dass der eigentlich nahe liegende Menübefehl Format > Linie 

verfügbar wird. 
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6 Individuelle Gestaltung und Standardeinstellungen 

6.1 Individuelle Gestaltung von Landkartenschichten 

Nun machen wir uns endlich daran, geographische Objekte von Landkartenschichten optisch zu gestalten, 
wobei wir aber noch nicht auf die Merkmale (Spalten) in den RegioGraph-Tabellen zurückgreifen, son-
dern die Attribute einzelner Objekte direkt manipulieren. Zwei Voraussetzungen für dieses Unterfangen 
dürften Ihnen mittlerweile vertraut sein: 

 Der Landkarten-Modus ist aktiv. 
Setzen Sie nötigenfalls einen Doppelklick auf die zu gestaltende Karte. 

 Im Karteninhaltsfenster ist der Arbeitslayer passend gewählt. 

In dieser Situation lassen sich (teilweise abhängig vom Typ des Arbeitslayers) über das Format-Menü 
zahlreiche Attribute von markierten geographischen Objekten ändern, z.B.: 

  Füllung von Gebieten und Flächen 
  Linientyp von Strecken sowie von Gebiets- oder Flächenbegrenzungen 

 
Wie z.B. bei der Bundesländerkarte in der Einleitung zu sehen ist, wird die Farbe von Gebieten häufig zur 
Datenvisualisierung verwendet, wobei der datenabhängige Farbton eines Gebiets mit einer individuell 
vergebenen Farbe konkurriert. RegioGraph sorgt jedoch dafür, dass die individuelle Gestaltung einer Kar-
tenschicht mit der Datenvisualisierung koexistieren kann. Das Programm kennt im Landkarten-Modus 
eine spezielle Darstellungsart zur Anzeige und Gestaltung individueller Attribute, die über den Menü-
befehl: 

Analysen > Individuelle Formatierung 

oder das Steuerelement1  aus der Symbolleiste Format aktiviert wird. Anschließend wird eine Karte 
unter Verwendung der individuellen Farben neu gezeichnet. 
 
Ändert man bei angezeigter Datenvisualisierung ein in Konkurrenz stehendes individuelles Attribut (z.B. 
die Farbe eines Gebiets), dann wird im folgenden Dialog informiert und ein Wechsel zur individuellen 
Formatierung angeboten: 

 
Manche Attribute von geographischen Objekten kollidieren nicht mit einer datenabhängigen Visualisie-
rung und bleiben daher bei allen Darstellungsarten in Kraft (z.B. der Linietyp von Gebietsbegrenzungen). 
 

6.2 Transparente Gebiets- oder Flächenschichten 

Wenn eine Gebiets- oder Flächenschicht über anderen Schichten liegt, kann es sinnvoll sein, sie transpa-
rent darzustellen. Dann werden nur die Umrisse gezeichnet, aber keine Füllungen, so dass die darunter 
liegenden Schichten sichtbar bleiben. Diese Darstellungsart ist in RegioGraph nach dem Einfügen einer 
Gebiets- oder Flächenschicht voreingestellt und kann im Landkarten-Modus mit dem Steuerelement1  
aus der Symbolleiste Format oder dem Menübefehl 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den diversen (größtenteils datenabhängigen) Darstellungsar-

ten. Die zuletzt benutzte Option ist im Steuerelement direkt anwählbar. 
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Analysen > Transparente Darstellung 

für den Arbeitslayer eingestellt werden. 
 

6.3 Standardeinstellungen für Layer 

Wird ein Layer mit einer bestimmten Attributkonfiguration in einem Projekt häufiger benötigt, sollte die-
se Konfiguration zum (projektinternen) Standard für den Layer erklärt werden. Im Bundesländerprojekt 
bietet sich dieses Vorgehen für eine Gebietsschicht an, die aus der Vorlage Bundesländer Deutsch-
land 2008 folgendermaßen entsteht: 

 Alle alten Bundesländer ausblenden und die neuen Bundesländer in das Kartenformat einpassen 
 Alle Grenzlinien in schwarzer Farbe mit der Strichstärke 1 mm 
 Beschriftungen mit bestimmter Schriftart und -größe 
 Feste individuelle Farben für alle neuen Bundesländer 

Einen entsprechend gestalteten Arbeitslayer kann man mit dem Menübefehl: 

Landkarte > Als Standard übernehmen 

als Standard (mit Gültigkeit für das Projekt) festlegen. Es erscheint folgender Dialog zur Auswahl der 
Attribute, die in den Standard einfließen sollen: 

 
Wird diese Schicht später aus der Projektverwaltung in eine Karte eingefügt, dann haben alle Attribute 
sofort den gewünschten Wert. Es bietet sich an, die beim Import der Schicht aus der Kartenbibliothek 
übernommene Bezeichnung (z. B. Bundesländer Deutschland 2008) nach dem Setzen neuer Stan-
dardwerte zu verändern. Selbstverständlich kann ein Projekt verwandte Schichten enthalten, die sich 
durch verschiedene Standardattribute unterscheiden. 
 
Nach der verunglückten Gestaltung einer Kartenschicht kann man mit dem folgenden Befehl zur (projekt-
internen) Standardkonfiguration zurückkehren: 

Landkarte > Standardeinstellungen laden 

 
Nach dem Befehl Landkarte > Als Standard übernehmen gilt der neue Standard zunächst nur für 
die aktuelle Sitzung. Beim Beenden von RegioGraph bzw. beim Schließen des Projekts wird im folgen-
den Dialog das Speichern des neuen Layer-Standards angeboten: 
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Soll ein modifizierter Layer auch in anderen Projekten verwendet werden, speichert man ihn als neue 
Vorlage ab. Dazu öffnet man in der Projektverwaltung das Kontextmenü des Layers und wählt die Option 
in der Kartenbibliothek speichern. In der folgenden Dialogbox ist ein Layer- und ein Dateiname 
(mit dem kompletten Pfad und der Namenserweiterung lay) anzugeben, z.B.: 

 
Um die Vorlage später in ein Projekt übernehmen zu können, muss über Extras > Optionen > Ver-
zeichnisse das Vorlagenverzeichnis passend eingestellt werden (siehe Abschnitt 3.3). 
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7 Mit Tabellen arbeiten 
Zu jeder RegioGraph-Kartenschicht gehört eine Tabelle, die z.B. per Doppelklick auf ihren Layer-Eintrag 
in der Projektverwaltung zu öffnen ist. Die Tabelle zur Gebietsschicht Bundesländer Deutschland 
2008 enthält im Auslieferungszustand bereits etliche Spalten: 

 
Das Tabellenfenster belegt per Voreinstellung den gesamten Dokumentenbereich und überdeckt ggf. 
offene Arbeitsblattfenster, kann aber z.B. mit der Menüzeilen-Schaltfläche  zu mehr Bescheidenheit 
gezwungen werden. 
 
Jede Tabelle enthält mindestens die beiden folgenden, nicht löschbaren Spalten: 

 Identifikationsspalte 
In der ersten Spalte ist jedes geographische Objekt der Schicht durch einen eindeutigen Wert identifi-
ziert. 

 Gehört zu 
Diese Spalte wird bei der Aggregation von Objekten zu neuen Einheiten benötigt. 

Neben dem (veränderbaren) Titel besitzen die Tabellenspalten noch eine in Klammern angehängte inter-
ne Bezeichnung, die in Formeln zur Berechnung von Spalten (siehe unten) zu verwenden ist. 
 
Für die Einträge einer Tabellenspalte kommen folgende Datentypen in Frage: 

  Ganzzahl 

  Dezimalzahl 

  Text 

7.1 Daten in eine Layertabelle importieren 

RegioGraph kann aus folgenden Quellen neue Variablen in eine Layertabelle übernehmen: 

 Dateien 
Unterstützte Dateiformate: 

- MS-Access 
- MS-Excel 
- dBase II, IV, V 
- Textdateien 

 Windows-Zwischenablage 
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Aus der Windows-Zwischenablage können z.B. Text- oder Excel-Daten übernommen werden. 
 ODBC-Datenbanken 
 
Aus nahe liegenden Gründen muss die zu importierende Datenmatrix eine Identifikationsspalte enthal-
ten, die zusammen mit dem Gegenstück in der Layertabelle regelt, welchem Objekt eine Importzeile zu-
geordnet werden soll. 
 
Nach dem Menübefehl 

Datei > Import 

erscheint folgende Dialogbox, die den Import von Daten oder geographischen Objekten (z.B. Punkten) 
in einen Layer sowie die Ausführung einer aufgezeichneten Importspezifikation (siehe unten) ermöglicht: 

 
 
Wir behandeln im Folgenden exemplarisch den Datenimport aus der Textdatei bl08.txt mit Tabulator-
getrennten Werten in die Gebietstabelle der deutschen Bundesländer. Die Importdatei enthält Informatio-
nen zu den 16 Bundesländern, die im Mai 2008 vom Statistischen Bundesamt im Rahmen der informatio-
nellen Grundversorgung zur Verfügung gestellt wurden (© Statistisches Bundesamt, Wiesbaden 2008). 
Sie ist in diesem PDF-Dokument enthalten und kann mit dem Anzeigeprogramm Adobe Acrobat (Reader) 
nach dem Menübefehl 

Anzeige > Navigationsregisterkarten > Anlagen 

per Maus (Ziehen und Ablegen) oder über den Schalter  entnommen werden. 
 
Wählen Sie im ersten Dialog des Import-Assistenten die Option 

Daten in folgenden Layer einfügen: Bundesländer Deutschland 2008 

und machen Sie dann weiter. 
 
RegioGraph erfragt den Namen der Importdatei: 
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Anschließend ist anzugeben, welche Datenorganisation (Trennzeichen versus Spalten mit fester 
Breite) und welchen Zeichensatz die Textdatei verwendet: 

 
Wir wählen die Option durch Trennzeichen getrennt sowie den westeuropäischen Zeichensatz 
und machen weiter. 
 
Im nächsten Dialog übernehmen wir das vorgeschlagene Trennzeichen Tabulator und teilen mit, dass 
der ersten Zeile die Spaltentitel zu entnehmen sind: 
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Nun schlägt RegioGraph Datentypen und Attribute für die zu importierenden Variablen vor, wobei nur 
selten Nachbesserungen nötig sind: 

 
 
Anschließend ist einiger Aufwand erforderlich bei der Übernahme von Spalten der Importdatei in neue 
oder in bereits vorhandene Spalten der Zieltabelle: 

 
 
Um eine Variable als Importspalte neu in die Tabelle aufzunehmen, setzt man einen Doppelklick auf 
ihren Namen, z.B.: 
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Im Beispiel wurde die Spalte name nicht importiert, weil sie mit der bereits vorhandenen Layer-Spalte 
Bundesland identisch ist. Um eine Importspalte wieder zu entfernen, setzt man einen erneuten Dop-
pelklick auf ihren Namen. 
 
Zur Übernahme in eine bereits vorhandene Tabellenspalte zieht man die zu importierende Spalte per 
Maus auf die Zelle links neben dem Ziel, wobei in der  - Spalte per Mausklick zwei Modi wählbar 
sind: 

 bisherige Werte überschreiben 

+ neue Werte zu den bisherigen addieren (nur möglich bei numerischen Variablen) 

Ist das Kontrollkästchen in der  - Spalte markiert, wird die Zielspalte vor dem Import geleert. Diese 
Einstellung hat allerdings nach meinen Erfahrungen keinen relevanten Einfluss auf den Datenimport. 
 
Man muss auf jeden Fall über ein Paar von Abgleichspalten festlegen, welchem Objekt der Layertabelle 
eine Importzeile zugeordnet werden soll: 

 Ziehen Sie die Import-Abgleichspalte per Maus auf die Zelle links neben der Layer-Abgleichspalte. 
 Klicken Sie in der  - Spalte auf die Zeile zu diesem Paar. 

Im Beispiel ist die Importspalte kennung mit der Tabellenspalte Bundeslandkennziffer abzuglei-
chen: 
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Dabei trifft eine Layer-Textspalte auf eine Import-Ganzzahlspalte, wobei im nächsten Assistentendialog 
der Zahlenvergleich zu bevorzugen ist: 

 
 
Wir machen noch einmal weiter und erhalten die Erfolgsmeldung: 

 
 
Lässt man alle Importspezifikationen in eine imp-Datei speichern, kann diese später zur automatisierten 
Wiederholung des aufgezeichneten Imports dienen (siehe oben). 
 
Nach dem erfolgreichen Import stehen in der Tabelle zur Bundesländer-Gebietsschicht zahlreiche weitere 
Variablen zur Verfügung: 
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7.2 Manuelle Tabellenbearbeitung 

7.2.1 Spalten erstellen und modifizieren 

Die Werte in den Zellen von nicht gesperrten Spalten (siehe unten) können wie in vergleichbaren Win-
dows-Anwendungen (z.B. MS-Excel) geändert werden. Es ist z.B. möglich, ganze Spalten oder andere 
rechteckige Tabellenbereiche via Zwischenablage mit Werten zu versorgen. 
 
Die im Folgenden beschriebenen Bearbeitungsmöglichkeiten für Spalten sind in der Regel über das (per 
Maus-Rechtsklick erreichbare) Kontextmenü einer Spalte verfügbar. 
 

7.2.1.1 Neue Spalte erstellen 

Gehen Sie folgendermaßen vor, wenn Sie z.B. hinter der Spalte C eine weitere Spalte einfügen wollen: 

 Wählen Sie die Option Neue Spalte aus dem Kontextmenü zur Spalte C. 
 Legen Sie in der folgenden Dialogbox einen Titel und einen Datentyp fest, z.B.: 

 
Mit dem Kontrollkästchen Formatieren wird bei numerischen Spalten ein Tausendertrennzeichen 
aktiviert. 

 

7.2.1.2 Dialogfeld Spalteneigenschaften 

Über die Kontextmenüoption Eigenschaften ist folgender Dialog mit diversen Einstellungsmöglichkei-
ten erreichbar: 

 
Über Allgemein kann man … 

 den Titel der Spalte ändern. 
 die Werte der Spalte in Landkarten mit einem Präfix und/oder Suffix anzeigen lassen 
 die Eingabe sperren, also Schreibschutz für eine Spalte vereinbaren 
 mehrzeilige Textspalten zulassen 

Dies ist sinnvoll bei längeren Bezeichnungen, die in Karten angezeigt werden sollen. Um in solchen 
Fällen die Texteingabe zu erleichtern, sollten Sie in den betroffenen Zeilen mehr Platz schaffen. Pa-
cken Sie dazu im Bereich der Zeilenbeschriftungen (am linken Tabellenrand) die betroffenen Zeilen-
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grenzen mit der Maus an, und stellen Sie eine geeignete Zeilenhöhe ein. Ein Zeilenumbruch wird per 
Enter-Taste erzeugt, z.B.: 

 
 die Länge von Textspalten ändern 

Es geht um die Gesamtzahl der Zeichen, wobei ein Zeilenwechsel zwei Zeichen belegt. 
 
Über Zahlenformat kann man das Tausendertrennzeichen und die Anzahl der Dezimalstellen 
wählen: 

 
 
In der Abteilung Berechnung und Darstellung 

 
kann man … 

 verschiedene Varianten für die Darstellung der Werte in der Tabelle und in Landkarten anfordern, 
z.B. absolute Werte, absolute Abweichung vom Mittelwert, Prozent der Summe 
Mit absolut ist das Gegenteil von prozentual gemeint. 

 verschiedene Balkendarstellungen in der Tabelle anfordern, z.B. Abweichungsbalken für die in Ab-
schnitt 7.1 importierte Variable UNFREL3 mit der Anzahl der Verkehrstoten pro 1 Million Einwoh-
ner: 
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 die Werte einer Spalte über eine Formel berechnen lassen 

Bei Ganzzahl- und Dezimalspalten können Sie bei Berechnungsart die Voreinstellung keine 
durch Formel ersetzen und dann einen arithmetischen Ausdruck angeben. Im folgenden Beispiel 
(Spalte GSREL) wird die biologische Änderung der Einwohnerzahl in den Bundesländern (Geburten - 
Sterbefälle) in Relation zur Anzahl der Einwohner gesetzt: 

 
In dem arithmetischen Ausdruck dürfen Sie verwenden: 

- Buchstabencode von Spalten 
Eine abgeleitete Spalte reagiert dynamisch auf spätere Wertänderungen bei einer Quellspalte. 
Weil intern eindeutige Spaltennamen verwendet werden, wirken sich spätere Änderungen bei 
der Spaltenreihenfolge (siehe unten) nicht aus. 

- Numerische Konstanten 
- Die Operatoren Addition (+), Subtraktion (-), Division (/) und Multiplikation (*) 
- Klammern 
- Funktionsnamen, z.B. SQRT(), POW() 
- Verzeigung (IF) 

Nähere Informationen zu den Funktionen und zur Verzeigung finden Sie in der Hilfe über 

Inhalt > Formelsyntax 
 
In der Abteilung Schrift und Farben 
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kann man … 

 die Farben für Balkendarstellungen ändern 
 die Schriftart, -größe und -farbe für die Darstellung in der Tabelle ändern. 

 

7.2.1.3 Weitere Modifikationen einer Tabelle 

Um die Breite einer Spalte zu verändern, .... 

 klickt man auf den rechten Rand ihrer Kopfzelle, 
 bewegt bei gedrückter Maustaste den (optisch veränderten) Mauszeiger bis zum neuen rechten Rand 
 und lässt die Maustaste wieder los. 
 
Um eine Spalte zu verschieben, öffnet man per Kontextmenüoption Tabellenstruktur die folgende 
Dialogbox  

 
und bewegt die markierte Spalte mit den grünen Transportschaltern. Mit diesem Dialog lasen sich auch 
Spalten anlegen oder löschen. 
 
Um Spalten aus- oder einzublenden, öffnet man per Kontextmenü die folgende Dialogbox  

 
und sorgt für passende Markierungen. 
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Man kann die Zeilen einer Tabelle per Kontextmenü auf- oder absteigend nach einer Spalte sortieren 
lassen. Für eine komplexere Sortierung fordert man über die Kontextmenüoption Sortieren > nach 
mehreren Spalten die folgende Dialogbox an, z.B.: 

 
 
Um den Wert einer bestimmten Zelle eines markierten Bereiches auf alle anderen markierten Zellen zu 
übertragen, wählt man aus dem Kontextmenü zur Quellzelle die Option Auffüllen. So lassen sich z.B. 
die Zellen einer neuen Spalte bequem mit einem geeigneten Initialisierungswert versorgen: 

Neue Spalte anlegen und ge-
wünschten Initialisierungswert in 

die erste Zeile eintragen: 

Gesamte Spalte markieren (z.B. 
per Mauklick auf die 
Spaltenbeschriftung): 

Kontextmenü zur Quellzelle 
öffnen und Auffüllen: 

   
 
Auch das Löschen einer Spalte ist per Kontextmenü möglich. 
 

7.2.2 Tabellenzeilen bzw. geographische Objekte markieren 

Durch das Markieren einer Tabellenzeile wird auch das zugehörige geographische Objekt markiert und 
umgekehrt, so dass Sie je nach Situation die bequemere Markierungsmethode wählen können. 
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Eine einzelne Tabellenzeile wird durch einen Mausklick auf ihre Zeilenbeschriftung markiert. Durch er-
neutes Anklicken lässt sich eine einzelne Markierung wieder beseitigen. Um einen Zeilenbereich zu mar-
kieren, überstreicht man bei gedrückter Maustaste die Zeilennummernspalte mit dem Mauszeiger. Durch 
die beschriebenen Mausaktionen lassen sich auch mehrere, durch Lücken getrennte, Blöcke markieren. 
 

Über den Menübefehl 

Bearbeiten > Auswählen 

bzw. über das Steuerelement1  auf der Symbolleiste Standard sind noch andere Markierungsoptio-
nen verfügbar: 

  Alles auswählen Strg+A 

  Auswahl aufheben Strg+M 

  Auswahl umkehren 

  Auswahl nach oben 
Die markierten Zeilen werden an den Anfang der Tabelle verschoben. 

  Auswählen bis oben 
Beginnend mit dem aktuellen Aufenthaltsort der Zellenmarkierung werden alle Zeilen bis zum 
Anfang der Tabelle markiert. 

  Auswählen bis unten 
Beginnend mit dem aktuellen Aufenthaltsort der Zellenmarkierung werden alle Zeilen bis zum 
Ende der Tabelle markiert. 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den anschließend beschriebenen Optionen. Die zuletzt be-

nutzte Option ist im Steuerelement direkt anwählbar. 
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8 Kartographische Visualisierung von Daten 
In diesem Abschnitt sollen endlich die von RegioGraph gebotenen Methoden zur kartographischen Vi-
sualisierung von Daten behandelt werden, wobei die gemäß Abschnitt 7.1 importierten Daten Verwen-
dung finden. Diese Methoden setzen einen aktiven Landkarten-Modus und einen passend gewählten Ar-
beitslayer voraus. 
 
Werden für eine Schicht nacheinander mehrere Visualisierungen definiert, kann natürlich nur die aktuelle 
angezeigt werden. Jedoch werden die anderen Spezifikationen nicht verworfen, sondern in der Projektda-
tei zur späteren Wiederverwendung gespeichert. 
 
Sollen mehrere (kompatible) Visualisierungen (z.B. Gebietseinfärbung und Diagramme) simultan sicht-
bar sein, stapelt man entsprechend konfigurierte Schichten. 
 

8.1 Ausprägungen eines Merkmals mit beliebigem Messniveau 

Hier handelt es sich um eine univariate Darstellungstechnik für Layer von beliebigem Typ (außer Ob-
jekt), wobei für alle geographischen Objekte ihre Ausprägung bei einer numerischen oder textuellen Va-
riablen angezeigt wird. Im Unterschied zu vielen anderen Darstellungsmöglichkeiten werden die Vari-
ablenausprägungen nicht in Klassen eingeteilt. Damit eignet sich diese Darstellungsart insbesondere für 
diskrete (z.B. kategoriale) Merkmale mit relativ wenigen Ausprägungen. In der Bundesländertabelle be-
findet sich nach dem in Abschnitt 7.1 beschriebenen Datenimport eine Variable namens REG2008_05 mit 
den Landesregierungen im Mai 2008, die sich für eine Momentaufnahme der politischen Landschaft eig-
net. 
 
Mit dem Menübefehl 

Analysen > Merkmale 

oder dem Steuerelement1  auf der Symbolleiste Format wird folgende Dialogbox angefordert: 

 
Auf dem Registerblatt Daten zur Auswahl einer Variablen aus der Tabelle zum Arbeitslayer entscheiden 
wir uns für REG2008_05. 
 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Für jede Ausprägung der gewählten Variablen ist eine Darstellungsform zu wählen. Die nach dem Ankli-
cken der zugehörigen Stilzelle verfügbaren Optionen hängen vom Layertyp ab: 

 Bei einem Gebiets- oder Flächenlayer bietet die Dialogbox Füllung ihre zahlreichen Optionen an. 
Im Beispiel sollen Koalitionsregierungen durch Farbverläufe dargestellt werden, z.B. bei einer CDU-
geführten großen Koalition: 

 
Ein horizontaler Farbverlauf ist bei allen Koalitionsländern angemessen mit Ausnahme von Ham-
burg. Hier führt die Zugehörigkeit von zwei Nordseeinseln dazu, dass sich das eigentliche Stadtge-
biet am rechten Rand befindet, so dass nur die rechte Farbe des horizontalen Verlaufs erscheint. Bei 
einem alternativen Verlaufstyp 

 
wird das Standgebiet bunter. 

 Bei einem Punktelayer erscheint die Dialogbox Symbol: 

 

 Bei einem Linienlayer erscheint die Dialogbox Linientyp: 
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Bei einem Punktelayer kann man auf der Registerkarte Daten der Merkmale-Dialogbox mit dem Schal-
ter Gleiche Symbole das Symbol der ersten Variablenausprägung (hinsichtlich Form, Farbe und Grö-
ße) als Vorgabe für alle anderen übernehmen. Analog wird bei einem Linienlayer mit dem Schalter Glei-
che Linien der Linientyp der ersten Variablenausprägung auf alle anderen übertragen. 
 
Die Registerkarte Legende 

 
der Merkmale-Dialogbox bietet folgende Möglichkeiten: 

 Legende ein bzw. abschalten 
 Titel und Untertitel selbst formulieren oder Standardtexte verwenden 
 Schriftart für Titel, Untertitel und Legendentexte festlegen 
 Statt in einer Legendenspalte alle Kategorien untereinander zu listen, sind bei einer hohen Anzahl 

von Kategorien mehrere Spalten sinnvoll. 
 
Im Layout-Modus kann man die Legende optisch modifizieren, z.B. Hintergrundfarbe, Transparenz, Rah-
mentyp, Größe und Position ändern. Trotzdem wirken sich die anschließend im Landkarten-Modus per 
Merkmale-Dialog vorgenommenen Änderungen der Darstellung (z.B. Füllstile der Merkmalsausprägun-
gen, Legendentexte) weiterhin auf die individuell gestaltete Legende aus. Nach dem Trennen der Le-
gende (via Kontextmenü im Layout-Modus) sind alle Bestandteile (z.B. auch die Beschriftungen der 
Merkmalsausprägungen) beliebig änderbar. Allerdings entsteht so ein fixiertes Layout-Element, das nicht 
mehr reagiert, wenn im Landkarten-Modus per Merkmale-Dialog die Darstellung geändert wird. 
 
Für die politische Landschaft im Mai 2008 resultiert folgendes Bild: 
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8.2 Piktogrammdarstellung 

Bei der Piktogrammdarstellung kann man den geographischen Objekten einer Schicht mit beliebigem Typ 
(außer Objekt) datenabhängig Symbole (Piktogramme) anheften, wobei jedes Symbol eine dichotome 
Variable darstellt: Das Symbol erscheint bei einem geographischen Objekt genau dann, wenn dieses Ob-
jekt bei der zugehörigen Variablen einen von Null (numerischer Typ) bzw. von der leeren Zeichenfolge 
(Textvariablen) verschiedenen Wert hat. Im folgenden (nicht sehr ernst gemeinten) Beispiel wird unter-
sucht, ob Bundesländer ohne Bindestrich im Namen tendenziell eine überdurchschnittliche Pro-Kopf - 
Kaufkraft1 besitzen. Zu diesem Zweck wurden zwei Variablen in die Bundesländer-Gebietstabelle aufge-
nommen, die bei vorhandenem Merkmal (Bindestrich, Pro-Kopf - Kaufkraft > 105) den Wert Eins an-
nehmen und ansonsten eine Null. Mit dem Menübefehl 

Analysen > Piktogramme 

oder dem Steuerelement2  wird folgende Dialogbox angefordert: 

                                                 
1 Angeregt wurde diese Untersuchung durch die Interviewaussage eines deutschen Ministerpräsidenten (im Mai 2008), seine 

Landeskinder könnten froh darüber ein, nicht in irgendeinem „Bindestrichland“ zu leben. 
2 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Auf dem Registerblatt Daten … 

 legt man zunächst mit dem Listen-Steuerelement unten links die Anzahl der dargestellten dichoto-
men Merkmale fest (im Beispiel: zwei) 

 wählt man die Variablen, für die jeweils ein Piktogramm einen von Null verschiedenen Wert bei ei-
nem geographischen Objekt signalisieren soll 

 wählt man für jedes Merkmal ein Piktogramm nach einem Klick auf seine Symbolzelle: 

 
Das Bindestrichsymbol wurde über eine mit der Windows-Beigabe Paint erstellte Bitmap-Datei im 
PNG-Format (Portable Network Graphics) in die Symbolauswahl aufgenommen (vgl. Abschnitt 4.3). 

 kann man die Layerobjekte ausblenden 
Im Beispiel würden die Umrisse der Gebiete verschwinden. 

 wird man nur selten gleiche Symbole für alle Merkmale wählen. 
 entscheidet man sich zwischen einer individuellen oder einheitlichen Größe der Symbole 

 
Auf dem Registerblatt Legende wird im Beispiel veranlasst, dass für jedes Piktogramm die Anzahl der 
betroffenen Objekte angezeigt werden soll: 
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Auf dem folgenden Arbeitsblatt wurde die Legende abgetrennt (vgl. Abschnitt 8.1), um ihre Symbole 
vergrößern zu können: 

 
Bis auf die Ausnahme Baden-Württemberg sind tatsächlich in den Bindestrichländern keine Einkaufswa-
gen (als Symbol für hohe Kaufkraft) anzutreffen. 
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8.3 Klassen einer numerischen Variablen durch Füllstile oder Linientypen darstellen 

Bei dieser für Gebiets-, Flächen- und Linienlayer verfügbaren Darstellungsart wird eine numerische Va-
riable (Datentyp Ganzzahl oder Dezimal) erwartet und in Klassen unterteilt. Im folgenden Beispiel aus 
dem Bundesländerprojekt, das (mit einer größeren Anzahl von Klassen) schon in der Einleitung zu sehen 
war, geschieht dies mit der importierten Variablen UNFREL3, welche die 2006 beobachtete Anzahl von 
Verkehrstoten pro 1 Million Einwohner enthält: 

 
Das Visualisieren von Klassen per Füllung oder Linientyp wird mit dem Menübefehl 

Analysen > Flächen und Linien nach Klassen 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Auf dem Registerblatt Daten kann für die ausgewählte Datenspalte sehr flexibel eine Klasseneintei-
lung definiert werden: 

 Über das Aufklappmenü Werteverteilung (Symbolschalter ) legt man fest, nach welchem Prin-
zip die Kategoriengrenzen festgelegt werden sollen: 

o Gleichverteilt 
RegioGraph bildet gleich stark besetzte Klassen. 

o Gleiche Abstände 
RegioGraph bildet gleich breite Intervalle. Diese Variante wird im Beispiel benutzt. 

o Statistisch verteilt 
Am linken bzw. rechten Rand wird jeweils eine Klasse mit den Fällen jenseits der Grenze von 
zwei Standardabweichungen unter bzw. über dem arithmetischen Mittelwert gebildet. Dazwi-
schen werden gleich breite Klassen gebildet. 

o Natürliche Grenzen 
RegioGraph versucht, die Klassengrenzen zwischen Häufungszonen in der empirischen Vertei-
lung zu setzen. 

o Logarithmische Abstände 
RegioGraph bildet gleich breite Intervalle bzgl. der logarithmierten Daten. Dies führt zu einem 

konstanten Quotienten 
i

i

x

x 1  für aufeinander folgende Intervallgrenzen, z.B. x1 = 1, x2 = 10, x3 = 

100 usw. 

 Man kann die Anzahl der Klassen und das Verhalten an den Klassengrenzen festlegen. 
 Die automatisch gebildeten Klassengrenzen können durch individuelle Werte überschrieben werden. 
 Die Klassengrenzen lassen sich in einer Datei (mit Namenserweiterung cla) speichern ( ) bzw. von 

dort laden ( ). 
 
Das Daten-Registerblatt zeigt auch für jede Klasse die momentan gültige Darstellungsform. Nach einem 
Klick auf die entsprechende Zelle kann eine alternative Darstellung gewählt werden, wobei die Auswahl 
vom Layertyp abhängt. Statt individuelle Farben festzulegen, kann man über Schalter  einen Farbver-
lauf definieren. 
 
Das Registerblatt Verteilung unterstützt die Klassendefinition: 

 Für jeden aufgetretenen Wert zeigt ein schmaler Balken seine Häufigkeit. 
 Die Intervalle sind durch ihren aktuell gewählten Füllstil unterscheidbar gemacht. 

Im Beispiel haben alle Balken die Höhe Eins, weil kein Wert mehrfach auftritt: 
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Die Registerkarte Legende 

 
bietet folgende Möglichkeiten: 

 Legende ein bzw. ausschalten 
 Standardtexte (ab)wählen 
 Nach dem Ausschalten der Standardtexte lassen sich Titel, Untertitel und Legendentexte individuell 

formulieren. 
 Bei der individuellen Kategorienbeschreibung wird das Editieren eines Eintrags per Doppelklick er-

öffnet. Mit dem Doppelkreuz sorgt man für ausgerichtete Spalten. 
 Schriftarten für Titel, Untertitel und Legendentexte festlegen 
 Anzahl der Objekte in den Klassen einblenden 
 Statt in einer Legendenspalte alle Klassen untereinander aufzulisten, sollte man bei einer großen An-

zahl von Klassen die Spaltenzahl erhöhen. 
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8.4 Klassen einer numerischen Variablen durch Symbole darstellen 

Intervalle einer numerischen Variablen (Datentyp Ganzzahl oder Dezimal) können bei Schichten mit be-
liebigem Typ (außer Objekt) durch unterschiedliche Symbole dargestellt werden. Als Anwendungsbei-
spiel betrachten wir eine Darstellung der Sterberaten in den deutschen Bundesländern durch Grabkreuze 
passender Größe: 

 
Die Darstellung von Klasen durch Symbole wird mit dem Menübefehl 

Analysen > Symbole nach Klassen 

oder mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Auf dem Registerblatt Daten stehen die schon in Abschnitt 8.3 besprochenen Optionen zur Auswahl 
einer Variablen und einer Klasseneinteilung zur Verfügung. Das Beispiel verwendet fünf Klassen mit 
gleicher Breite. 
 
Über den Schalter Gleiche Symbole kann man das Symbol der ersten Klasse hinsichtlich Form, Farbe 
und Größe als Vorgabe für alle anderen übernehmen. Wenn man die Variablenausprägungen nicht nur 
durch Gestalt und Farbe der Symbole, sondern auch durch deren Größe zum Ausdruck bringen möchte, 
ist die individuelle Größe zu wählen. 
 
Für jede Klasse muss durch Anklicken ihrer Stilzelle die folgende Dialogbox geöffnet werden, um ein 
Symbol samt Farbe und Größe festzulegen, z.B.: 

 
Es verwundert, dass RegioGraph an dieser Stelle eine manuelle Größenangabe verlangt, statt passende 
Werte aus den Daten zu berechnen. Immerhin ermöglicht diese etwas umständliche Methode eine unein-
geschränkte Freizügigkeit beim Festlegen der Symbolgrößen zu den einzelnen Kategorien. RegioGraph 
bietet auch eine Symboldarstellung mit automatischer Größenberechnung, allerdings etwas versteckt un-
ter den Methoden zur Darstellung von Daten durch Diagramme über den speziellen Diagrammtyp Ska-
lierte Symbole (siehe Abschnitt 8.9). 
 
Um eine hohe Varianz der Symbolgrößen zu erreichen, wurden im Beispiel die mittleren Beobachtungs-
werte kx  (k = 1, .., 5) in den Klassen folgendermaßen transformiert: 

507
1000

 k
k

x
x  

So resultieren darstellungstechnisch günstige Symbolgrößen (in mm): 
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Intervall Mittelwert der Fälle 
 im Intervall 

Transformierter 
Wert 

   9265,18 8630,87 10,42 
9265,18 - 9899,49 9527,10 16,69 
9899,49 - 10533,80 10289,16 22,02 
10533,80 - 11168,12 10922,32 26,46 
11168,12 < 11598,90 31,19 

Um objektiv zu informieren und jeden Täuschungsverdacht zu vermeiden, wurden neben den Symbolen 
auch die tatsächlichen Sterberaten der Bundesländer auf der Karte angezeigt (siehe unten). 
 
Das im aktuellen Beispiel verwendete Symbol wurde mit einem Vektor-Grafikprogramm erstellt und im 
WMF-Format (Windows Meta File) abgespeichert. Wie man eigene Symbole in die RegioGraph-Palette 
aufnehmen und dauerhaft speichern kann, wurde schon in Abschnitt 4.3 behandelt. 
 
Auf dem Registerblättern Verteilung und Legende tauchen gegenüber der Beschreibung in Abschnitt 
8.2 keine Neuerungen auf. 
 
In der Legende zur aktuell behandelten Darstellungstechnik erscheinen die Symbole der Kategorien 
gleich groß, was nur bei Verwendung von unterschiedlichen Formen oder Farben zu einer informativen 
Anzeige führt. Im Beispiel wurde daher auf eine Legende verzichtet. 
 
In der Karte sollen (neben den Symbolen) die Namen der Bundesländer und die Sterberaten erscheinen. 
Realisiert man beide Angaben über die Beschriftung der Gebietsschicht, werden sie stets zusammenhän-
gend angezeigt, was die Gestaltungsfreiheit stark einschränkt. Daher wurde im Beispiel eine zusätzliche 
Bundesländer-Gebietsschicht zur Anzeige der Namen aufgenommen. So kann man die Namen der Bun-
desländer, die Sterberaten und die Symbole unabhängig voneinander verschieben (nach Wahl des passen-
den Layers und bei gedrückter Strg-Taste). Um die Symboldarstellung durch eine korrespondierende 
Einfärbung der Gebiete zu unterstützen, wurde in der unteren Gebietsschicht eine Darstellung der Sterbe-
raten durch Grautöne eingerichtet (siehe Abschnitt 8.3). 

  
Darstellung durch Farben, Anzeige der Ländernamen
Darstellung durch Symbole, Anzeige der Sterberaten 

 

8.5 Punktdichtedarstellung 

Für Häufigkeitsdaten zu Gebieten oder Flächen ist die Punktdichtedarstellung gut geeignet. Als Beispiel 
im Rahmen unseres Bundesländerprojekts drängt sich die Darstellung der Einwohnerzahl auf: 
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Eine Punktdichtedarstellung wird mit dem Menübefehl 

Analysen > Punktdichte 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Auf der Suche nach einer guten Darstellung kann man auf dem Registerblatt Daten mit dem Wert und 
der Punktgröße experimentieren. 
 
Wenn Ihnen die obige Karte zu blass erscheint, können Sie eine andere Hintergrundfarbe wählen, z.B.: 

 
Allerdings lässt sich die Hintergrundfarbe unter den Pünktchen nicht auf derselben Gebietsschicht reali-
sieren, weil die Individualfarben (vgl. Abschnitt 6.1) nicht gleichzeitig mit der Punktdichte dargestellt 
werden können. Die Lösung des Problems besteht darin, eine zweite Bundesländer-Gebietsschicht mit 
geeigneter Individualfärbung unter die Gebietsschicht mit der Punktdichte zu legen. 
 
Um die Lesbarkeit der Beschriftungen zu verbessern, wurden sie nach 

Format > Schrift 

freigestellt: 
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8.6 Portfolio-Darstellung 

Mit der Portfolio-Darstellung, die bei Gebiets-, Flächen-, und Linienlayern zur Verfügung steht, können 
für die geographischen Merkmalsträger die Ausprägungen von zwei numerischen Variablen simultan dar-
gestellt werden. Im Bundesländer-Beispiel soll mit dieser Technik untersucht werden, ob in Ländern mit 
hoher ärztlicher Versorgungsdichte die Sterberate tendenziell niedriger ausfällt. Das Streudiagramm für 
die Regression von STERBREL auf ARZTREL zeigt allerdings erhebliche strukturelle Unterschiede zwi-
schen den Stadt- und den Flächenländern, so dass eine gemeinsame Analyse nicht sinnvoll ist: 

 
Daher werden in der Portfolio-Darstellung nur die Flächenländer berücksichtigt: 
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Die Länder Berlin, Bremen und Hamburg mit ihrer extrem hohen Ärztedichte wurden durch Ausblenden 
der Gebiete (vgl. Abschnitt 5.6) ausgeschlossen. Um ihre Flächen neutral gelb erscheinen zu lassen, wur-
de eine passend konfigurierte zweite Bundesländer-Gebietsschicht über die Schicht mit der Portfolio-Dar-
stellung gelegt. 
 
Die Portfolio-Darstellung wird mit dem Menübefehl 

Analysen > Portfolio 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 
Auf dem Daten-Registerblatt muss in Bezug auf die X- und die Y-Achse klassifiziert werden, wobei pro 
Variable maximal vier Kategorien erlaubt sind. 
 
Im Beispiel wird zur Darstellung der Ausprägungskombinationen folgendes Schema angewendet:  

 Eine niedrige, mittlere oder hohe Ärztedichte wird durch die Hintergrundfarben Weiß, Blassrosa oder 
Rot ausgedrückt. 

 Um die drei Klassen bzgl. der Sterberate auszudrücken, erscheinen keine, schlanke oder kräftige 
Kreuze, realisiert durch geeignete Muster. 

 
Nach einem Mausklick auf die Portfolio-Matrixzelle einer Ausprägungskombination erscheint die Dia-
logbox Füllung. Um ein vorhandenes Muster auf die aktuelle Zelle anzuwenden, … 

 wechselt man nötigenfalls auf die Registerkarte Muster, 
 wählt eine Vorder- und eine Hintergrundfarbe, 
 markiert die gewünschte Zelle per Mausklick, so dass ihr Muster in der Vorschau unten rechts er-

scheint, z.B. 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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 und übernimmt die Wahl per OK. 
 
Um ein eigenes Muster zu kreieren, setzt dann einen Rechtsklick auf eine vermutlich nicht mehr benötig-
te Vorlage und kann schließlich in der Dialogbox Muster editieren für einen Pixel per Mausklick zwi-
schen Vorder- und Hintergrundfarbe wechseln, wobei eine (8  8) - Pixelmatrix zur Verfügung steht: 

 
RegioGraph speichert diese Änderungen (wie z.B. auch ergänzte Symbole und selbst erstellte Linienstile) 
in der aktuellen Palette, die über 

Format > Palette 

in eine pal-Datei gespeichert und in einer späteren Sitzung von dort geladen werden kann. 
 
Eine zur Portfolio-Technik vergleichbare bivariate Darstellung lässt sich auch durch eine Mehrschicht-
technik erzielen, z.B. 

 mit einer Gebietsbasisschicht zur farblichen Darstellung der ärztlichen Versorgungsdichte 
 und einer darüber liegenden Gebietsschicht mit Symboldarstellung für die Sterberate. 



 

AWS.RG.3: 11. November 2009 80 

Thematische Kartographie mit RegioGraph 10 
 

Baden-
Württemberg

Hessen

Rhl.-Pfalz

Saarl.

Schleswig-
Holstein

Niedersachsen

Nordrhein-
Westfalen

Thüringen

Sachsen-
Anhalt

Sachsen

Brandenburg

Mecklenburg-
Vorpommern

Bayern

8.631

9.494

10.341

11.710

10.524

10.273

10.175

10.965

11.802

11.284

10.296

10.126

9.522

Quelle: Statistisches Bundesamt (Stand:  2005)

Ärztliche Versorgungsdichte
und Sterberate

(Nur Flächenländer)

 
 
Bei einer Portfolio-Darstellung für eine Linienschicht ist für jede Matrixzelle ein eigener Linientyp fest-
zulegen. 
 
Eine statistische Analyse der Pearson-Korrelation zwischen ARZTREL und STERBREL zeigt übrigens 
keinen signifikanten Zusammenhang (ohne Berlin, Bremen und Hamburg): 

     
Ärzte pro 1000 

Einwohner 

Sterbefälle 
pro 1 Mio 
Einwohner 

Korrelation nach Pearson 1 -,315 
Signifikanz (1-seitig)  ,147 

Ärzte pro 1000 Einwohner 

N 13 13 
Korrelation nach Pearson -,315 1 
Signifikanz (1-seitig) ,147   

Sterbefälle pro 1 Mio Ein-
wohner 

N 13 13 

 

8.7 Symbol-Portfolio 

Die Symbol-Variante der Portfolio-Darstellung eignet sich für alle Layertypen. Ihre Besonderheit gegen-
über dem Standard-Portfolio besteht darin, dass den Matrixzellen Symbole zugewiesen werden, die in 
Form, Farbe und Größe variieren können. 
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Das Symbol-Portfolio wird mit dem Menübefehl 

Analysen > Symbol-Portfolio 

bzw. mit dem Steuerelement1  angefordert. 
 

8.8 Dreidimensionale Darstellungen 

8.8.1 3D-Gitter (Gebirgs-Darstellung) 

Bei dieser univariaten Darstellungsart wird ein Gitter über die Landkarte gelegt, und zu jeder Gitterzelle 
wird ein Farb- und ein Höhenwert für die darzustellende numerische Variable berechnet. Zu den Werten 
einer Zelle liefern alle in ihrem Bereich liegenden geographischen Objekte (Gebiete, Flächen, Linien oder 
Punkte) einen Beitrag, wobei abhängig vom Typ des Layers unterschiedliche Kombinationsmethoden zur 
Verfügung stehen. Während bei einem Punktelayer in einer einzelnen Zelle durchaus mehrere Objekte zu 
erwarten sind, erstrecken sich Gebiete oder Flächen meist über mehrere Zellen. 
 
Leider findet sich im Bundesländerprojekt kein gutes Beispiel für eine Gitter-Darstellung. Vermutlich 
haben Sie schon eine bessere Veranschaulichung der Pro-Kopf - Verschuldung in den deutschen Bundes-
ländern gesehen: 

 
Das 3D-Gitternetz wird über den Menübefehl 

Analysen > 3D Gitternetz 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Die spezifischen Bedienelemente der Dialogbox 3D-Gitter befinden sich auf dem Registerblatt Gitter: 

 Im Rahmen Gitterzellen können Sie … 

 festlegen, wie viele Zellen in vertikaler bzw. horizontaler Richtung gebildet werden sollen, 
 ein Zellenraster zeichnen lassen (wie im Beispiel geschehen), 
 entscheiden, was mit Zellen passieren soll, die kein geographisches Objekt beinhalten bzw. 

tangieren. 

 Welche Berechnungsarten zur Verfügung stehen, hängt teilweise vom Layertyp ab. Bei Gebiets- 
oder Flächenschichten können Sie unter folgenden Verfahren wählen: 

 Petrovskii-Verfahren 
Der Wert eines Gebietes oder einer Fläche wird anteilig auf die darauf liegenden Zellen ver-
teilt. Diese Methode ist angemessen, wenn der Wert durch Kumulieren über die gesamte Flä-
che entstanden ist (z.B. Einwohnerzahl). Der Wert eines großen Gebietes wird auf viele Zellen 
aufgeteilt, die jeweils einen kleinen Anteil erhalten. 

 Hauptwert-Verfahren 
Der Wert eines Gebietes oder einer Fläche wird von allen darauf liegenden Zellen übernom-
men. Diese Methode ist angemessen, wenn der Wert ohne Relativierung am Flächeninhalt in-
terpretiert werden kann (z.B. Kaufkraftindex pro Einwohner). Alle Zellen über einem großen 
Gebiet erhalten denselben, unveränderten Wert. 

Für die Darstellung der Pro-Kopf - Verschuldung ist offenbar das Hauptwert-Verfahren angemessen. 

 Mit dem Höhenregler wählen Sie die Ausdehnung der Karte in der dritten Dimension. 

 Mit dem Glättungsfaktor legen Sie fest, wie stark die Höhe der Nachbarzellen berücksichtigt wer-
den soll. 

 
Auf dem Registerblatt Daten wird nach dem üblichen Schema eine Klasseneinteilung definiert. Klassiert 
werden nicht die ursprünglichen Merkmalsausprägungen der geographischen Objekte, sondern die resul-
tierenden Höhenwerte der Zellen. 
 
Das Erscheinungsbild einer 3D-Gitternetz - Darstellung hängt entscheidend von der Perspektive ab, die 
nach dem Menübefehl 

Landkarte > Perspektive 

                                                                                                                                                                            
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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mit dem folgenden Werkzeug eingestellt werden kann: 

 
 

8.8.2 3D-Prismen - Darstellung 

Bei dieser univariaten, auf Gebiets- oder Flächenlayer beschränkten Darstellungsart werden Gebiete oder 
Flächen in Abhängigkeit von der dargestellten numerischen Variablenausprägung unterschiedlich hoch 
aus der Ebene herausgehoben. Die resultierenden „Tafelberge“ eignen sich vermutlich besser zur Darstel-
lung der Pro-Kopf - Schulden in den Bundesländern als die im letzten Abschnitt benutzte Gitternetztech-
nik: 

 
Die 3D-Prismen-Darstellung wird über den Menübefehl 

Analysen > 3D Prismen 
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bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 
Auf dem Registerblatt Daten finden sich zwei spezielle Steuerelemente: 

 Mit dem Kontrollkästchen Gleiche Höhe können Sie bestimmen, ob die Höhenzuwächse der einzel-
nen Plateaus identisch oder analog zu den Werten der Klassen ausfallen sollen. 

 Mit dem Schieber Höhe wird ein Multiplikator für die Höhenwerte zu den einzelnen Klassen ge-
wählt. 

 

8.9 Darstellung durch Diagramme 

 RegioGraph bietet folgende Diagramm-Grundtypen, von denen jeweils mehrere Varianten existieren: 

 Kreise  Flächen 

 Ringe  Auszählungen 

 Segmentflügel  Klaiberdiagramme 

 Sterne  Skalierte Symbole 

 Balken  Körper 

 Stapel  Linien 

Um z.B. die Landesergebnisse der Bundestagswahl 2005 dazustellen, bietet es sich an, zu jedem Bundes-
land ein eigenes Kreisdiagramm zu zeichnen: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Aus rein ästhetischen Gründen wurde der Gebietslayer Höhenschichten Deutschland als Unterlage 
verwendet. Die Legende wurde im Layoutmodus komplett manuell erstellt. 
 
Um die Kreisdiagramme in obiger Karte durch Balkendiagramme zu ersetzen, sind nur wenige Maus-
klicks erforderlich. Für die Ästhetik im Untergrund sorgt diesmal Gebietslayer Schummerung 
Deutschland: 
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Die Diagrammdarstellung wird über den Menübefehl 

Analysen > Diagramme 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert: 

 
Bei der Spezifikation von Kreisdiagrammen legt man nach der Typ-Bestimmung auf dem Daten-
Registerblatt die Variablen zu den einzelnen Kreissegmenten fest und sorgt für eine passende Farbe. 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 



 

AWS.RG.3: 11. November 2009 87 

Thematische Kartographie mit RegioGraph 10 
 
Hinsichtlich der Skalierung der Diagrammwerte wählt man z.B. bei Balkendiagrammen zwischen folgen-
den Alternativen: 

 Werte sind in allen Diagrammen vergleichbar 
Die Balkenhöhen sind auch zwischen zwei Diagrammen vergleichbar. 

 Werte innerhalb eines Diagramms vergleichbar 
RegioGraph legt die Balkenwerte in jedem Diagramm separat nach lokalen Kriterien festgelegt, so 
dass z.B. gleich hohe Balken in verschiedenen Diagrammen i.A. nicht denselben Wert ausdrücken. 

 
Auf eine Beschriftung der Kreisdiagramme 

 
wurde im Beispiel verzichtet. Wenn genügend Platz vorhanden, ist, kann man sie auf dem Registerblatt 
Beschriftung anfordern. 
 
In der folgenden Abbildung werden skalierte Symbole verwendet, um die Stimmanteile der Grünen dar-
zustellen: 
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Hier leistet RegioGraph die in Abschnitt 8.4 (Klassen einer numerischen Variablen durch Symbole dar-
stellen) vermisste automatische Orientierung der Symbolgrößen an den dargestellten Merkmalsausprä-
gungen. Das Symbol wurde aus einer Datei im WMF-Format (Windows Meta File) importiert. 
 

8.10 Entfernung zum nächsten oder zum zugeordneten Standort 

Für die Objekte einer Gebiets-, Flächen oder Punkteschicht kann die Entfernung zum nächstgelegenen 
Standort auf einer Punkteschicht farblich dargestellt werden. Im folgenden Beispiel ist für die Gemeinden 
in Rheinland-Pfalz die Entfernung zur nächsten Stadt mit mehr als 100.000 Einwohnern dargestellt: 

 
Sofern der Arbeitslayer Gebiete, Flächen oder Punkte enthält und außerdem noch eine Standortpunkt-
schicht verfügbar ist, kann die Entfernungsanalyse mit dem Menübefehl 

Analysen > Entfernung zum nächsten Standort 

bzw. mit dem Steuerelement1  angefordert und in folgender Dialogbox spezifiziert werden: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Auf dem Daten-Registerblatt wird die Standortpunktschicht gewählt und die Entfernung auf gewohnte 
Weise in Klassen eingeteilt. 
 
In obige Karte wurden noch die Autobahnen als wesentliche Verbindungswege aufgenommen, was die 
Eisenbahnfans mir nachsehen mögen. Die fette Außengrenze des Bundslands stammt von einer Bundes-
land-Gebietsschicht, so dass insgesamt folgende Schichten beteiligt sind: 

 
 
Die Einschränkung auf Rheinland-Pfalz kann folgendermaßen realisiert werden: 

 Auf allen Schichten die unerwünschten Objekte außerhalb von Rheinland-Pfalz ausblenden (vgl. Ab-
schnitt 5.6) 

 Das Gebiet Rheinland-Pfalz markieren und einpassen (vgl. Abschnitt 5.5) 
 
In der Umgebung von Ludwigshafen fallen einige Gebiete mit verblüffender Nähe zum Oberzentrum auf. 
Durch Markieren findet man heraus, dass offenbar einige Orte über nicht zusammenhängende Gebiete 
verfügen (z.B. Weisenheim am Sand, blau gefärbt). 

 
 
Soll sich die Entfernungsmessung nicht auf den nächstgelegenen, sondern auf einen speziell zugewiese-
nen Standort aus einer Punkteschicht beziehen, ist in der Tabelle mit den zu messenden Objekten eine 
Variable mit den zugeordneten Standorten erforderlich. Mit dem Menübefehl 

Analysen > Entfernung zum zugeordneten Standort 
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bzw. mit dem Steuerelement1  fordert man die folgende Dialogbox an, die im Vergleich zur obigen 
Variante zusätzlich die Registerkarte Standorte bietet: 

 
Wegen der stattlichen Anzahl rheinland-pfälzischer Gemeinden wird darauf verzichtet, eine Variante von 
obiger Karte herzustellen. 
 

8.11 ABC-Analyse 

Bei der ABC-Analyse für eine Gebiets-, Flächen- oder Punkteschicht kann man z.B. für eine Umsatzvari-
able darstellen, welche Objekte (bei absteigender Sortierung nach Umsatz) für p1, p2, … Prozent des Ge-
samtumsatzes gesorgt haben. In der folgenden Karte ist zu sehen, auf welche Bundesländer man sich be-
schränken kann, wenn man 50, 75, 90 oder 95 Prozent der Ärzte ansprechen möchte: 

 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Man fordert die Dialogbox zur Spezifikation einer ABC-Analyse mit dem Menübefehl 

Analysen > ABC-Analyse 

oder mit dem Steuerelement1  an: 

 
Hier wählt bzw. ändert man: 

 die darzustellende numerische Variable 
 die Anzahl der Klassen 
 die Art der Klassengrenzen 
 die Werte der Klassengrenzen 
 die Farben der einzelnen Kategorien oder einen Farbverlauf 
 die Gestaltung der Legende 
 
Bei der regionalen ABC-Analyse (Menübefehl Analysen > Regionale ABC-Analyse, Steuerelement 

) verteilt man die Objekte auf separat behandelte Regionen, so dass etwa regionale Umsatzschwer-
punkte erkennbar werden. 
 

8.12 Radialanalyse 

Bei der für Gebiets-, Flächen- und Punkteschichten verfügbaren Radialanalyse kann man z.B. für eine 
Umsatzvariable und einen Standort die Umkreise darstellen, deren Objekte p1, p2, etc. Prozent des Ge-
samtumsatzes erbringen. 
 
Sind mehrere Standorte vorhanden, … 

 wird jedes Objekt dem nächstgelegenen Standort zugeordnet 
 werden die Umkreise für jeden Standort separat gebildet 
 bildet die Summe aller Beiträge der Objekte eines Standorts die Bezugsgröße für Prozentangaben 
 
In der folgenden Abbildung werden die Kaufkraftsummen der deutschen Gemeinden in den Einzugsbe-
reichen der Metropolen Trier und Berlin dargestellt. Dazu kommt neben der Gebietsschicht mit den deut-
schen Gemeinden, die von RegioGraph inklusive Kaufkraftdaten geliefert wird, eine geeignete Punkt-
schicht mit den beiden Standorten zum Einsatz. Für jede Metropole sind die kleinstmöglichen Umkreise 
mit den Gemeinden zu sehen, die bereits 20, 40, 60, 80 bzw. 100 Prozent der Standort-Kaufkraftsumme 
beisteuern: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Zum dunkelgrünen Kreis um Trier gehört eine Gemeinde genau dann, … 

 wenn ihre Entfernung von Trier geringer ist als ihre Entfernung von Berlin 
 wenn sie zum kleinstmöglichen Umkreis um Trier gehört, der bereits 20% der zu diesem Standort 

gehörenden Kaufkraftsumme erbringt. 
 
ABC- und Radialanalyse unterscheiden sich in Bezug auf das Kriterium für die Anordnung der geogra-
phischen Objekte: 

 Bei der ABC-Analyse werden die Objekte nach der Zielvariablen (z.B. Umsatz) absteigend geordnet. 
 Bei der Radialanalyse werden die Objekte nach der Entfernung zu einem Standort aufsteigend geord-

net. Sind mehrere Standorte vorhanden, werden die Objekte dem jeweils nächstgelegenen zugeordnet. 
 
Man fordert die Dialogbox zur Spezifikation einer Radialanalyse mit dem Menübefehl 

Analysen > Radial-Analyse 

oder mit dem Steuerelement1  an: 

                                                 
1 Per Mausklick auf das kleine Dreieck erscheint ein Menü mit den in Abschnitt 8 beschriebenen Darstellungsoptionen. Die 

zuletzt beim aktuellen Arbeitslayer benutzte Option ist im Steuerelement direkt anwählbar. 
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Hier wählt bzw. ändert man: 

 die Punkteschicht mit den Standorten 
 die darzustellende numerische Variable 
 die Anzahl der Klassen 
 die Art der Klassengrenzen 
 die Werte der Klassengrenzen 
 die Farben der einzelnen Kategorien oder einen Farbverlauf 
 die Gestaltung der Legende 
 
Wie bei der ABC-Analyse existiert auch zur Radialanalyse eine regionale Variante. 
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9 Grafik-Export 

9.1 Export via Zwischenablage 

Ein RegioGraph-Arbeitsblatt kann bequem via Windows-Zwischenablage komplett oder teilweise in eine 
andere Anwendung übernommen werden. Dabei ist zu beachten: 

 Ausgangspunkt ist ein im Layout-Modus geöffnetes Arbeitsblatt. 
 Sind Markierungen vorhanden, werden nur die markierten Layout-Objekte übertragen, anderenfalls 

werden alle Layout-Objekte übertragen. Achten Sie also bei der geplanten Übertragung eines kom-
pletten Arbeitsblatts darauf, dass keine Markierungen vorhanden sind. 

 Das Übertragen in die Zwischenablage wird wie üblich mit Bearbeiten > Kopieren oder Strg+C 
angefordert. 

 Im Zielprogramm übernimmt man die Karte mit Bearbeiten > Einfügen oder Strg+V. 

Die Karten werden im Enhanced-Metafile-Format (EMF) eingefügt, so dass verlustfreie Größenänderun-
gen und flexible Nachbearbeitungen möglich sind. 
 

9.2 Export in eine Datei 

Über den Menübefehl 

Datei > Exportieren 

können Sie ein Arbeitsblatt (stets komplett) in eine Datei exportieren: 

 Wählen Sie im ersten Assistentendialog das Speichern als Grafik: 

 

 Im nächsten Dialog 
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wählt man: 

o Das Arbeitsblatt 
o Das Grafikdateiformat 

RegioGraph unterstützt die Bitmap-Formate PNG, GIF, TIF, BMP und JPEG sowie das Vektor-
format EMF. 

o Den Dateinamen 
o Größe und Auflösung 
o Farbtiefe 

Im Beispiel entsteht eine platzsparende PNG-Datei mit einer Bildschirm-adäquaten Auflösung, die 
aber beim Drucken keine optimale Qualität liefert. 

 

9.3 HTML-Export 

Über den Menübefehl 

Datei > Exportieren 

kann man ein Arbeitsblatt zusammen mit ausgewählten Daten als interaktives HTML-Dokument expor-
tieren: 

 Wählen Sie im ersten Assistentendialog das Speichern als HTML-Dokument: 

 
 Im nächsten Dialog 
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wählt man: 

o Das Arbeitsblatt 
o Die Bildbreite- und -höhe 

Im Beispiel wurde für den Bildschirmauftritt ein quadratisches Arbeitsblatt erstellt. 
o Die Ausrichtung der Karte im Browser-Fenster 
o Den Namen der HTML-Datei 

 Für die Quickinfo-Ausgabe im Internet-Browser kann man Merkmale aus einer Schichttabelle wäh-
len und jeweils einen Präfix sowie einen Suffix1 festlegen. Im Beispiel sollen die Ergebnisse der Bun-
destagswahl 2005 angezeigt werden: 

 
Unter Hyperlinks wird festgelegt, was beim Mausklick auf ein geographisches Objekt geschehen 
soll: 

o Anzeige einer von RegioGraph automatisch erstellte HTML-Seite mit Tabellendaten 
o Aufruf einer URL, die sich in einer Spalte der Layertabelle befinden muss 

 
Im Beispiel werden automatisch erstellte Tabellen gewählt, so dass insgesamt 18 Dateien (mit einer be-
scheidenen Gesamtgröße von 166 KB) resultieren: 

 eine Datei mit der HTML-Startseite 
 eine GIF-Datei mit der Karte 

                                                 
1 Auf ein Suffix wurde im Beispiel verzichtet, weil sich das gewünschte Resultat nicht erzielen lies. 
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 für jedes Bundesland eine HTML-Datei mit einer Tabelle 

Das Ergebnis: 

 
 
Per Mausklick auf ein Bundesland erhält man eine Tabelle mit Detailangaben, z.B. für Rheinland-Pfalz: 
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10 Weitere Möglichkeiten in RegioGraph 
Von den vielen RegioGraph-Optionen, die in diesem Manuskript nicht behandelt wurden, sind folgende 
besonders heraus zu heben: 

 Berechnungen von Flächen, Entfernungen etc. 
RegioGraph kann u.a. Flächen, Umfänge, Längen und Entfernungen (zum nächstgelegenen oder zuge-
ordneten Standort) berechnen und in einer Layertabelle ablegen (siehe Menü Berechnungen). 

 Importieren von geographischen Objekten 
Über den Menübefehl 

Datei > Import 

lassen sich nicht nur Merkmale in eine Schichttabelle importieren (siehe Abschnitt 7.1), sondern es 
können auch neue Punkte oder Linien in eine vorhandene oder neue Schicht von passendem Typ im-
portiert werden. Bei der Lokalisation der neuen Objekte sind zwei Verfahren möglich: 

o Die neuen Punkte oder Linien werden über ein Abgleichkriterium den Objekten eines vorhande-
nen Abgleichslayers zugeordnet. So lassen sich z.B. Punkte in Gebiete importieren, wobei Regio-
Graph eine Zufallsverteilung vornimmt. 

o Zu den neuen Punkten oder Linien werden Koordinaten importiert. 

 Districting 
Die auf Gebietsschichten enthaltenen Basisgebiete können zu größeren Gebietseinheiten zusammenge-
fasst werden. Die mit den Basisgebieten verknüpften Daten werden dabei automatisch ebenfalls aggre-
giert. Durch wiederholte Aggregation kann eine Gebietshierarchie erstellt werden. Änderungen der 
Gebietsstruktur und/oder der Daten werden dynamisch auf allen Gebietsebenen übernommen. 
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11 Stichwortregister 

3 
3D-Gitter  81 
3D-Prisma  83 

A 
ABC-Analyse  90 
Abgleichspalten  55 
Access  51 
Aggregation  98 
Arbeitsblätter  8, 12 
Arbeitsblattfenster  15 
Arbeitsblattvorlage  14 
Arbeitslayer  27 
Auffüllen  61 
Ausrichten  25 

B 
Basisgebiete  98 
Berechnungen  98 
Beschriftungen  34 

D 
Daten importieren  51 
Datentyp  51 
dBase  51 
Dezimalstellen  58 
Diagramme  84 
Districting  98 
Drehen  40 

E 
Eigenschaftsdialog  24 
Einpassen einer Karte  32 
Ellipse  18 
EMF  79, 94 
Enhanced-Metafile-Format  79, 94 
Entfernung 

zum nächsten Standort  88 
zum zugeordneten Standort  89 

Entfernungsmessung  37 
ESRI Shape  5 
Excel  51 
Exportieren 

in Datei  94 
über Zwischenablage  94 

F 
Farbe 

transparente  19 
Flächen  7 
Flächenlayer  46 
Formate übertragen  24 
Formelsyntax  59 
Fragmentierung der Projektdatei  13 
freistellen  76 
Füllung 

von Flächen  20 

G 
Gebiete  7 

Basisgebiete  98 
Gebirgs-Darstellung  81 
Geographische Objekte 

aus- und einblenden  33 
GfK  6 
GIS-Software  5 
Gitter-Darstellung  81 
Gitternetz  39 
Grafik 

aus Datei  18 
aus Palette  18 

Grafikobjekte  17 
Größe anpassen  26 
Gruppieren  26 

H 
Hauptwert-Verfahren  82 
Horizontal verteilen  26 
Horizontal zentrieren 

Bzgl. Arbeitsblatt  25 
Bzgl. Objekt  25 

HTML-Export  95 

I 
imp-Datei  56 
Importieren 

von Daten  51 
von Punkten oder Linien  98 

Importspezifikation  56 
Infolayer  29, 35 
Infos zu geographischen Objekten  35 
Initialisierungswert  61 

K 
Karten, mitgelieferte  5 
Kartenbibliothek  10 
Karteninhalt  27 
Karteninhalt  13 
Kaufkraftdaten  6 
Kennung  7 
Kippen  40 
Klassengrenzen  70 
Kreis  18 

L 
Landkarten-Modus  14 
Layer  10 

erstellen  42 
Layout-Modus  14, 17 
Legende  65, 71 
Linie  17 
Linien  44 
Linienenden  22 
Linientyp  21 
Linksbündig  25 
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M 
MapInfo Interchange Format  5 
Markieren 

geographische Objekte  30 
Grafikobjekte  20 
Zeilen einer Tabelle  61 

Maßstab  38 
Muster editieren  79 

N 
Nordpfeil  39 

O 
Oben ausrichten  25 
Objekte, geographische  7 
Objektelayer  46 
ODBC  52 
Ole-Objekt einfügen  19 

P 
Palette  18, 79 
Perspektive  40, 82 
Petrovskii-Verfahren  82 
Piktogrammerstellung  66 
PNG  67 
Polygon  17 
Portable Network Graphics  67 
Portfolio-Darstellung  77 
Prismen-Darstellung  83 
Projektdatei  10 
Projekte  8 
Projektion  41 
Projektverwaltung  10 
Punktdichtedarstellung  74 
Punkte  7 
Punktelayer  42 

Q 
Quadrat  18 

R 
Radialanalyse  91 
Rechteck  18 
Rechteck, gerundet  18 
Rechtsbündig  25 
Reorganisieren  13 
Rückgängig machen 

im Landkartenmodus  27 
im Layout-Modus  17 

S 
Schatten  23 
Schicht 

aktive  27 
Schichten  7 
Schriftart  22, 29 
Sichern  27 

Skalierte Symbole  87 
Spalte 

löschen  61 
Spalten 

Sortieren  61 
Spalten 

aus- und einblenden  60 
sperren  57 
verschieben  60 

Spalteneigenschaften  57 
Standardeinstellungen  49 
Stapelordnung verändern  25 
Statistisches Bundesamt  52 
Strecken  7 
Symbol 

hinzufügen  74 
Symbol-Darstellung  72 
Symbol-Portfolio  80 

T 
Tabelle  7 
Tabellen 

Spalten sperren  57 
Tabellenbearbeitung  51 
Tabellenfenster  15, 51 
Tabulator-getrennte Textdateien  52 
Tausendertrennzeichen  57, 58 
Textfeld  18 
Titel 

einer Tabellenspalte  57 
Transparente Farbe  19 
Transparente Schichten  48 

U 
Übertragen 

von Formaten  24 
Unten ausrichten  25 

V 
Verteilen  26 

horizontal  26 
vertikal  26 

Vertikal verteilen  26 
Vertikal zentrieren 

Bzgl. Arbeitsblatt  25 
Bzgl. Objekt  25 

Verzeigung  59 
Vorlagen 

erstellen  50 
übernehmen  10 

Vorlagenverzeichnis  11 

W 
Windows Meta File  74, 88 
WMF  88 
WMF-Format  74 

Z 
Zentrieren  22 
Zoom-Funktion  29 
Zwischenablage  94 
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